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Kapitel 1 
Einführung 

Einführung 
Die PQ Analyze Software ist ein umfassendes und vielseitiges Werkzeug für alle Ihre 
Analyse-, Auswertungs- und Berichterstellungsaufgaben. 

Sie unterstützt eine Vielzahl verschiedener Analysetypen, darunter: 

• Pegel-Zeit-Diagramm 

• Wahrscheinlichkeitsfunktion 

• Balkendiagrammansicht 

• Tägliche Statistik  

Das Programm inkludiert verschiedene Exportfunktionen von einfachen textbasierten 
Exporten über Excel- und Word-Exporte bis hin zu einem umfassenden 
anwenderkonfigurierbaren Reportgenerator. 

Der integrierte „Online Betrieb“ (Live Mode) ermöglicht die Echtzeit-Anzeige der real an 
den Eingangskanälen anliegenden Abtastwerte und Transientensignale. 

Die umfangreiche Trigger-Engine, die sowohl Echtzeit-Trigger als auch Trigger mit 
aggregierten Werten ermöglicht, kann im Fenster Einstellungen (Settings) zusammen 
mit vielen anderen Konfigurationsparametern eingestellt werden. Alle Einstellungen 
lassen sich in Konfigurationsvorlagen für eine schnelle Gerätekonfiguration vor Ort 
speichern. 

Die Software unterstützt verschiedene Methoden des Geräteanschlusses (Ethernet, 
serielles Kabel) und stellt somit ein ideales Werkzeug für viele unterschiedliche 
Anwendungen dar. 

PQ Analyze unterstützt Störungsbehebungsaufgaben ebenso wie Langzeitaufzeichnungen 
und die statistische Auswertung des Stromnetzes. 

Das Programm ist ein ebenso leistungsfähiges wie benutzerfreundliches Werkzeug zur 
Analyse schwieriger und komplexer Netzqualitätsprobleme. Eine Liste der neuen 
Funktionen finden Sie unter www.Fluke.com , wo Sie auch die neueste Version von PQ 
Analyze herunterladen können. 
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Umfang dieses Handbuchs  
Dieses Handbuch erläutert die Funktionen des Fluke 1760 Power Quality Recorder. Die 
PQ Analyze Software unterstützt auch die älteren Topas 1000-Geräte. Einige Teile dieses 
Handbuchs gelten jedoch nicht für den Topas 1000. 

Hinweis 
Vor 2009 wurden die Rekorder mit einem USB-Verbindungskabel geliefert. 
Dieses Kabel ist nun nicht mehr im Lieferumfang enthalten. Es wird von 
der Software weiterhin unterstützt, wird jedoch in diesem Handbuch nicht 
mehr behandelt.   

Symbole 
Symbol Beschreibung 

X Gefährliche Spannung. Stromschlaggefahr. 

W Wichtige Informationen. Siehe Handbuch. 

- Nicht in der Nähe von GEFÄHRLICHEN SPANNUNGSFÜHRENDEN 
Leitern anwenden oder davon entfernen. 

J Erde, Masse 

T Schutzisoliert. 

B AC (Wechselstrom) 

F DC (Gleichstrom) 

P Übereinstimmung mit den EU-Vorschriften. 

) Canadian Standards Association ist die Zertifizierungsstelle für 
Übereinstimmungsprüfung für Sicherheitsstandards. 

~ Dieses Produkt nicht im unsortierten Kommunalabfall entsorgen. 
Informationen zum Recycling sind der Website von Fluke zu 
entnehmen. 

; Entspricht den relevanten australischen Normen. 

Kontaktaufnahme mit Fluke 
Wählen Sie eine der folgenden Telefonnummern, um Fluke zu kontaktieren: 

• Technischer Support USA: 1-800-44-FLUKE (1-800-443-5853) 

• Kalibrierung/Instandsetzung USA: 1-888-99-FLUKE (1-888-993-5853) 

• Kanada: 1-800-36-FLUKE (1-800-363-5853) 

• Europa: +31 402-675-200 

• Japan: +81-3-3434-0181 

• Singapur: +65-738-5655 
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• Weltweit: +1-425-446-5500 

Oder die Website von Fluke unter www.fluke.com besuchen. 

Zur Produktregistrierung http://register.fluke.com besuchen. 

Die neuesten Handbücher sind unter http://us.fluke.com/usen/support/manuals erhältlich. 

Postanschrift: 

Fluke Corporation     Fluke Europe B.V. 
P.O. Box 9090,     P.O. Box 1186, 
Everett, WA 98206-9090  5602 BD Eindhoven 
U.S.A.     Niederlande 

Open-Source-Lizenzen 
Die Firmware, die auf das Gerät heruntergeladen werden kann, enthält urheberrechtlich 
geschützte Software, die Open-Source-Lizenzen unterliegt. Die entsprechenden 
Lizenzdokumente finden Sie im Unterverzeichnis „Lizenzen“ (licenses) des 
Installationsverzeichnisses des Programms. 

Für Programme, die von der „GNU General Public License (GPL)“ berührt werden, sind 
die Quellen verfügbar.  

Wenn Sie in Europa ansässig sind, können Sie eine CD mit den Quellen kostenlos per E-
Mail (service@de.fluke.nl), Telefon (+4901805232432) oder FAX (+4901805232433) 
bestellen. 

Wenn Sie andernorts in der Welt ansässig sind, verwenden Sie das Formular „contact us“ 
unter http://register.fluke.com/globalforms/uSContactUs.asp. 
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Kapitel 2 
Installation der Software 

Systemvoraussetzungen 
Für einen problemlosen Betrieb der Software muss das System folgende 
Voraussetzungen erfüllen:  

System Voraussetzungen 

PC IBM-kompatibel 

Prozessor Pentium  500 MHz Minimum, 2 GHz empfohlen 

RAM 256 MB Minimum, 1 GB empfohlen 

 freier Speicher mindestens: 50 MB für die PQ Analyze 
Software 

Betriebssystem Microsoft Windows® 2000 / XP ≥SP3/Vista 

Netzwerk Ethernet IEEE 802.3x 10Base-T oder 100Base-T 

Laufwerk  1024x768 Monitor, Tastatur, Maus, CD-ROM 

 

Für die Verwendung der verschiedenen Exportfunktionen ist eine der unten aufgeführten 
Microsoft Office-Versionen erforderlich:  

• MS Office 2000 

• MS Office XP 

• MS Office 2003 

• MS Office 2007 
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Installieren der PQ Analyze Software 

Hinweis 
Für die Installation der Software sind Administratorrechte erforderlich. 
Falls Schwierigkeiten auftreten, wenden Sie sich an den 
Systemadministrator.  

Legen Sie die mitgelieferte Installations-CD in das CD-ROM-Laufwerk des PCs. Falls 
das CD-ROM-Laufwerk für AutoAusführen konfiguriert ist, startet das 
Softwareinstallationsprogramm automatisch. Falls das CD-ROM-Laufwerk nicht für 
AutoAusführen (Autorun) konfiguriert ist, starten Sie das Installationsprogramm durch 
Doppelklick auf launch.exe im MS Explorer®-Fenster. 

1. Wenn die CD angelaufen ist, klicken Sie auf Install PQ Analyze Software. 

 
launcher1.jpg 

2. Das Setup-Programm der Software wird gestartet. Folgen Sie den 
Installationsanweisungen auf dem Bildschirm. 

3. Es wird empfohlen, den PC neu zu starten, um den Installationsvorgang 
abzuschließen.  

Hinweis 
Falls auf dem PC eine frühere Version der PQ Analyze Software installiert 
ist, wird diese automatisch ersetzt. Wenn dies nicht der Fall ist, entfernen 
Sie sie manuell. 
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Installationspfade 
Von der Version 1.8.6 der PQ Analyze Software an werden Daten, Vorlagen usw. in 
anderen Pfaden gespeichert als bei früheren Softwareversionen. Der Grund hierfür ist die 
Kompatibilität mit Microsoft Vista. Die Pfade bei Microsoft Windows XP und Vista sind 
üblicherweise unterschiedlich. In dieser Unterlage werden diese Verzeichnisse als 
<Anwendungsdaten> (AppData) und <Persönlich> (Personal) angegeben. 

Verzeichnis <Anwendungsdaten> (AppData) 
Dieser Ordner enthält anwenderspezifische Dateien, die von Anwendungen installiert 
werden. PQ Analyze speichert Vorlagen, die Konfiguration usw. im Verzeichnis 
<Anwendungsdaten>\PQAnalyze (<AppData>\PQAnalyze). Um den Speicherort dieses 
Verzeichnisses zu bestimmen, führen Sie die folgenden Schritte durch: 

1. Doppelklicken Sie auf dem Desktop des Rechners auf „Eigene Dateien“ (My 
Documents), geben Sie %APPDATA% in das Feld „Adresse“ (Address) ein, und 
drücken Sie die Eingabetaste: 

 
G_mydocsappdata.bmp 

2. Das Verzeichnis <Anwendungsdaten> (AppData) wird geöffnet und sein 
Speicherort im Feld „Adresse“ (Address) angezeigt.  

• Der übliche Pfad bei XP: C:\Dokumente und 
Einstellungen\<Benutzername>\Anwendungsdaten (C:\Documents and 
Settings\<YourUserName>\Application Data) 

• Der übliche Pfad bei Vista: 
C:\Benutzer\<Benutzername>\Anwendungsdaten\Servergespeichert 
(C:\users\<YourUserName>\AppData\Roaming)   
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Verzeichnis <Persönlich> (Personal) 
Dieser Ordner ist der Standardspeicherort zum Speichern von Anwendungsdateien. PQ 
Analyze speichert Messdaten, Berichte usw. im Verzeichnis <Persönlich>\PQAnalyze 
(<Personal>\PQAnalyze). Um den Speicherort dieses Verzeichnisses zu bestimmen, 
führen Sie die folgenden Schritte durch: 

1. Klicken Sie auf dem Desktop des Rechners mit der rechten Maustaste auf Eigene 
Dateien (My Documents), und wählen Sie Eigenschaften (Properties) aus: 

 
G_mydocspropsselect.bmp 
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2. Der Speicherort des Verzeichnisses <Persönlich> (Personal) wird im Feld Ziel 
(Target) des Eigenschaftsfensters von Eigene Dateien (My Documents) angezeigt: 

 
G_mydocsprops.bmp 

• Der übliche Pfad bei XP: C:\Dokumente und 
Einstellungen\<Benutzername>\Eigene Dateien (C:\Documents and 
Settings\<YourUserName>\My Documents) 

• Der übliche Pfad bei Vista: C:\Benutzer\<Benutzername>\Dokumente 
(C:\users\<YourUserName>\Documents) 
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Kapitel 3 
Kommunikation mit dem Rekorder 

Einführung 
Der Rekorder unterstützt verschiedene Kommunikationsmethoden. Er verfügt über eine 
automatische Netzwerküberwachungsfunktion und schaltet dynamisch IP-Adressen um, 
wenn die Ethernet-Schnittstellenverbindung geändert oder entfernt wird.  

Die bevorzugte Kommunikationsmethode mit dem Rekorder ist Ethernet LAN-
Kommunikation mit DHCP-Unterstützung, da dies in den meisten Netzwerkumgebungen 
ohne Konfiguration funktioniert (DHCP-Server erforderlich, weitere Informationen 
erhalten Sie bei Ihrem Netzwerkadministrator). 

Sollte dies auf Ihre Applikation nicht zutreffen, ist die nächstbeste Lösung die direkte 
Peer-to-Peer-Kommunikation über gekreuztes Ethernetkabel. Diese Methode funktioniert 
ebenfalls ohne Konfiguration, hat aber den Nachteil, dass die Netzwerkschnittstelle des 
PCs belegt wird und Sie somit nicht gleichzeitig auf das lokale Netzwerk zugreifen 
können. Die Peer-to-Peer-Kommunikation empfiehlt sich in erster Linie für direkte 
Verbindungen mit dem Rekorder (z. B. wenn Sie das Gerät am Messort installieren, um 
die Signale zu kontrollieren oder Messeinstellungen zu ändern).  

Wenn Sie dem Rekorder eine feste IP-Adresse zuweisen möchten, finden Sie 
entsprechende Informationen unter „Ethernet LAN-Kommunikation mit festen IP-
Adressen“. 

Für spezielle Anwendungen gibt es auch die Methoden der Kommunikation über direktes 
RS232-Kabel und der Kommunikation mit Modems. Aufgrund der geringen 
Geschwindigkeit wird serielle Kommunikation nicht empfohlen. 
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Ethernet-LAN-Kommunikation mit DHCP-Unterstützung 
1. Schalten Sie den Rekorder ein, und verbinden Sie ihn mit Ihrem Local Area 

Network (LAN). Eine gültige IP-Adresse wird automatisch zugewiesen. 

2. Starten Sie die Betriebs- und Auswertungssoftware PQ Analyze. 

3. Schließen Sie das Start Menü (Start Menu) durch Klicken auf Abbruch 
(Cancel). 

4. Rufen Sie das Menü TransferFluke 1760/Geräte suchen (TransferFluke 
1760/Search Devices) auf: 

 
transfer2000.bmp 

 

 

5. Sind auf Ihrem Computer mehrere Netzwerkschnittstellen installiert, wählen Sie 
aus der Liste Netzwerk (Network) die LAN-Schnittstelle. Klicken Sie auf 
Suchen (Search).  Nach einigen Sekunden wird die Liste der im Local Area 
Network gefundenen Geräte angezeigt. 

  
SearchDevices_US.bmp 

 

6. Wählen Sie Ihr Gerät, und klicken Sie auf Verbinden (Connect), um eine 
Verbindung zwischen Fluke 1760 und Ihrem Computer aufzubauen. In der 
Statuszeile werden Verbindungsinformationen angezeigt. 

 
status line.bmp 

Mit der Schaltfläche Speichern (Save) öffnen Sie ein Fenster zur Anzeige der 
Stationsliste: 
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ConfigSites_US.bmp 

Ein neu gefundenes Gerät kann durch Eingabe einer spezifischen Bezeichnung 
zur Liste der Stationen hinzugefügt werden. Später kann mit diesem Namen auf 
den Fluke 1760 verwiesen werden. 

7. Da die IP-Adresse bekannt ist, kann auch vom Übertragen (Transfer)-Menü aus 
eine Verbindung zum Fluke 1760 hergestellt werden. Die zuletzt verwendete 
IPAdresse wird dem Verbindungsdialogfeld als Standardwert übermittelt.  

 
t2000 search devices3.bmp 

 
t2000 search devices4.bmp 
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Direkte Peer-to-Peer-Kommunikation über gekreuztes 
Ethernetkabel 

1. Schalten Sie den Rekorder ein, und schließen Sie ihn mit dem Ethernet-
Crossover-Kabel (mit roten Steckern) an Ihren PC an. 

 
crossoverethernetcable.jpg 

2. Warten Sie 1 Minute. Der Rekorder benötigt diese Zeit, um den Schnittstellentyp 
zu ermitteln und die direkte Verbindung herzustellen. 
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3. Starten Sie die PQ Analyze-Software, und wählen Sie die Optionsfolge 
Übertragen > Fluke 1760 > Geräte suchen (Transfer > Fluke 1760 > Search 
devices). Ihr Gerät wird in der Liste angezeigt.  

4. Klicken Sie auf Verbinden (Connect), um eine Verbindung zwischen Fluke 
1760 und Ihrem Computer aufzubauen.  

 
searchdevices_us.bmp 

In der Statuszeile werden Verbindungsinformationen angezeigt: 

 
statusbar.bmp 

Hinweis 
Warten Sie beim Austauschen von Netzwerkschnittstellenkabeln mindestens 
5 Sekunden, bevor Sie wieder ein Kabel anschließen. Die 
Schnittstellenüberwachung braucht diese Zeit, um das abgetrennte Kabel 
zuverlässig zu erkennen. 
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Ethernet-LAN-Kommunikation mit festen IP-Adressen 
Gehen Sie dazu wie folgt vor: 

1. Stellen Sie eine Verbindung zum Rekorder her. Siehe auch „Kommunikation 
über direktes RS232-Kabel“. 

2. Wählen Sie im Menü Service > Erweiterte Einstellungen (Advanced Settings). 
Beim ersten Mal erscheint eine Sicherheitsmeldung (Prüfung der 
vertrauenswürdigen Verbindung). Klicken Sie auf Ja (Yes). 

 
puttysecurityalert.bmp 

 
advancedsettingsmainmenu.bmp 

3. Wählen Sie im Hauptmenü die Option 1. Netzwerkkonfiguration (1. Network 
Configuration), und drücken Sie die Eingabetaste. 
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advancedsettingsnetworkconfig.bmp 

4. Wählen Sie 3. Feste IP-Adresse (DHCP deaktivieren) (3. Fixed IP Address 
(disable DHCP)), und drücken Sie die Eingabetaste.  

 
advancedsettingsenterip.bmp 

5. Geben Sie die IP-Adresse ein, und drücken Sie die Eingabetaste. 

6. Geben Sie die IP-Netzmaske ein, und drücken Sie die Eingabetaste. 

7. Geben Sie das IP-Gateway ein (oder lassen Sie das Feld leer), und drücken Sie 
die Eingabetaste. Eine Warnmeldung zu möglichen Verbindungsverlusten wird 
angezeigt.  

8. Geben Sie „y“  ein, und drücken Sie die Eingabetaste. 
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Hinweis 
Bitte fragen Sie Ihren Netzwerkadministrator nach fester IP-Adresse, IP-
Netzmaske und Gateway. Falsche IP-Einstellungen können IP-
Adressenkonflikte zur Folge haben, die sich negativ auf andere Computer 
im Netzwerk auswirken können. 

 
advancedsettingsipchanged.bmp 

9. Drücken Sie die Eingabetaste, um die neuen Einstellungen anzuzeigen. 

 
advancedsettingsipchanged2.bmp 

10. Drücken Sie die Eingabetaste erneut, um zum Hauptmenü zurückzukehren. 

11. Beenden Sie die erweiterte Einstellungssitzung. 

12. Wählen Sie in der PQ Analyze-Software die Optionsfolge Transfer/Fluke 
1760/Ethernet und geben Sie die feste IP-Adresse des Geräts ein. Klicken 
Sie auf OK, um die Verbindung aufzubauen. 
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Hinweis 
Es ist nicht erforderlich, die Seriennummer des Rekorders anzugeben. 

Kommunikation über direktes RS232-Kabel 

Herstellung der seriellen Direktverbindung in Windows XP 

Hinweis 
Es ist nicht möglich, an demselben seriellen Port gleichzeitig eine direkte 
serielle Verbindung und eine Modemverbindung einzurichten. 
Deinstallieren Sie alle Modems, die den seriellen Port verwenden.  

Hinweis 
Die direkte serielle Verbindung verwendet das PPP-Protokoll. 

Gehen Sie wie folgt vor, um eine serielle Direktverbindung herzustellen:  

1. Öffnen Sie in der Windows-Systemsteuerung  (Windows Control Panel) die 
Netzwerkverbindungen (Network Connections). 

 
G_screen9.bmp 
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2. Starten Sie den Netzwerk-Installationsassistenten (New Connection 
Wizard), oder wählen Sie Datei > Neue Verbindung (File > New 
Connection). 

 
G_screen0.bmp 

3. Klicken Sie auf Weiter (Next). 

 
G_connectionwizard_1.bmp 

4. Wählen Sie Erweiterte Verbindung einrichten (Set up an advanced 
connection), und klicken Sie auf Weiter (Next). 
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G_connectionwizard_2.bmp 

5. Wählen Sie Direkt mit einem anderen Computer verbinden (Connect 
directly to another computer), und klicken Sie auf Weiter (Next).  

 
G_connectionwizard_3.bmp 
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6. Wählen Sie die Option Gast (Guest), und klicken Sie auf Weiter (Next). 

 
G_connectionwizard_4.bmp 

7. Geben Sie einen Namen für die Verbindung ein, und klicken Sie auf Weiter 
(Next). 

 
G_connectionwizard_5.bmp 
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8. Wählen Sie den seriellen Port, und klicken Sie auf Weiter (Next). 

 
G_connectionwizard_6.bmp 

9. Klicken Sie auf Weiter (Next). 

 
connectionwizard_7.bmp 
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10. Klicken Sie auf Fertigstellen (Finish). 

 
G_connectionwizard_8.bmp 

11. Wenn ein Fenster F1760_direkt verbinden (Connect F1760_direct) 
angezeigt wird, klicken Sie auf Abbrechen (Cancel).  

 
G_connectionwizard_8a.bmp 
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12. Gehen Sie zu Netzwerkverbindungen (Network Connections), und öffnen 
Sie das Eigenschaftsfenster für die neue Verbindung. 

 
G_nwc_p.bmp 



1760 
Referenzhandbuch 

3-16 

13. Öffnen Sie die Registerkarte Allgemein (General), und klicken Sie auf 
Konfigurieren… (Configure…).  

 
G_ogt.bmp 

14. Legen Sie alle Parameter wie unten abgebildet fest, und klicken Sie auf OK. 

 
G_modem_configuration.bmp 
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15. Aktivieren/Deaktivieren Sie alle Kontrollkästchen, wie unten abgebildet. 

 
G_oot.bmp 

 

16. Wählen Sie in der Netzwerk-Registerkarte (Networking) die Option 
Internetprotokoll (TCP/IP) (Internet Protocol (TCP/IP)), und klicken Sie 
auf Eigenschaften (Properties).  

 
G_dp.bmp 
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17. Wählen Sie Erweitert (Advanced), und deaktivieren Sie die Option 
Standard-Gateway auf Remote-Host verwenden (Use default gateway on 
remote host), und klicken Sie anschließend auf OK. 

 
G_ipp.bmp 

 

 
G_ats.bmp 

 

18. Schließen Sie alle Einstellungsfenster mit OK.  

19. Weiter mit „Überprüfung der seriellen Direktverbindung“. 
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Herstellung der seriellen Direktverbindung in Windows Vista 

 

Hinweise 
• Es ist nicht möglich, an demselben seriellen Port gleichzeitig eine 

direkte serielle Verbindung und eine Modemverbindung 
einzurichten. Deinstallieren Sie alle Modems, die den seriellen Port 
verwenden.  

• Die direkte serielle Verbindung verwendet das PPP-Protokoll. 

Wenn während des Installationsprozesses Ihre Zustimmung zur Fortsetzung des 
Vorgangs eingeholt wird, klicken Sie auf Weiter (Continue). Dies kann häufiger 
vorkommen, und der Text kann variieren. 

 
G_vistapermissions.bmp 

Zum Erstellen einer direkten seriellen Verbindung müssen Sie ein „Dummymodem“ 
installieren, die korrekte Baudrate festlegen und einen Netzwerkanschluss erstellen. 
Möglicherweise müssen Sie den Rechner neu starten, damit die korrekte Baudrate 
aktiviert wird (dies betrifft Windows Vista Business SP1). 
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Installieren eines Dummymodems 
1. Klicken Sie in der Windows-Systemsteuerung (Windows Control Panel) auf 

Hardware und Sound (Hardware and Sound). 

 
G_vistacontrolhardware.bmp 

2. Klicken Sie auf Telefon- und Modemoptionen (Phone and Modem Options). 

 
G_vistamodemoptions.bmp 
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3. Wählen Sie die Registerkarte Modems aus, und klicken Sie auf Hinzufügen... 
(Add...). 

 
G_vistamodemadd.bmp 

4. Aktivieren Sie das Kästchen Modem auswählen (Keine automatische 
Erkennung) (Don't detect my modem; I will select it from a list), und klicken 
Sie auf Weiter > (Next >). 

 
G_vistamodeminstallnew.bmp 
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5. Nach einigen Sekunden wird eine Liste der Modelle angezeigt. Wählen Sie 
Kommunikationskabel zwischen zwei Computern (Communications cable 
between two computers) aus, und klicken Sie auf Weiter > (Next >). 

 
G_vistamodemcomcable.bmp 

6. Wählen Sie Ihren COM-Port aus, und klicken Sie auf Weiter > (Next >). 

 
G_vistamodemselectport.bmp 
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7. Warten Sie, bis das Modem installiert worden ist. Klicken Sie anschließend auf 
Fertig stellen (Finish). 

 
G_vistamodemfinish.bmp 

8. Klicken Sie auf OK. 

 
G_vistamodemclose.bmp 
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Festlegen der Baudrate 
1. Klicken Sie in der Windows-Systemsteuerung (Windows Control Panel) unter 

Hardware und Sound (Hardware and Sound) auf Geräte-Manager (Device 
Manager). 

 
G_vistacontroldevicemanager.bmp 
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2. Öffnen Sie die Unterstruktur Modems , klicken Sie mit der rechten Maustaste auf 
Kommunikationskabel zwischen zwei Computern (Communications cable 
between two computers), und wählen Sie anschließend Eigenschaften (Properties) 
aus. 

 
G_vistadevicemodemcomcable.bmp 
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3. Wählen Sie die Registerkarte Modem  aus, und geben Sie die Maximale 
Übertragungsrate (Maximum Port Speed) ein (Der Standardwert des Rekorders ist 
57600 bps. Sie können den Wert ändern, indem Sie Menü Service > Erweiterte 
Einstellungen (Service > Advanced Settings) in PQ Analyze auswählen), klicken Sie 
auf OK , und schließen Sie den Geräte-Manager (Device Manager). 

 
G_vistadevicemodemcomcableproperties.bmp 

4. Starten Sie den Rechner neu. 



 Kommunikation mit dem Rekorder 
 Kommunikation über direktes RS232-Kabel 3 

  3-27 

Erstellen eines Netzwerkanschlusses 
1. Klicken Sie in der Windows-Systemsteuerung (Windows Control Panel) im 

linken Bereich auf Netzwerk und Internet (Network and Internet), und klicken 
Sie dann auf Netzwerk- und Freigabecenter (Network and Sharing Center). 

 
G_vistacontrolnetwork.bmp 

2. Klicken Sie auf Eine Verbindung oder ein Netzwerk einrichten (Set up a 
connection or network). 

 
G_vistanetworksetup.bmp 
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3. Wählen Sie Wählverbindung einrichten (Set up a dial-up connection) aus, und 
klicken Sie auf Weiter > (Next >). 

 
G_vistanetworksetupconnectionoption.bmp 

4. Wenn mehr als ein Modem installiert ist, werden Sie gefragt, welches Sie 
verwenden möchten. Klicken Sie auf das zuletzt installierte Modem 
(Kommunikationskabel zwischen zwei Computern (Communications cable 
between two computers)).  

 
G_vistanetworkmodemselect.bmp 
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5. Geben Sie eine Dummy-Einwählrufnummer und eine Verbindungsbezeichnung 
ein, und klicken Sie dann auf Verbinden (Connect). 

 
G_vistanetworkisp.bmp 

6. Windows prüft die Verbindung. Wenn bei der Prüfung ein Fehler auftritt, klicken 
Sie auf Die Verbindung dennoch einrichten (Set up the connection anyway) 
und dann auf Schließen (Close). 

 
g_vistanetworkcheckconnection.bmp 

7. Klicken Sie in der Systemsteuerung auf Netzwerkverbindungen verwalten 
(Manage network connections). 
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g_vistanetworkmanage.bmp 

8. Klicken Sie mit der rechten Maustaste auf die neue Verbindung, und klicken Sie 
dann auf Als Standardverbindung aufheben (Cancel as Default Connection). 

 
g_vistanetworkcanceldefault.bmp 



 Kommunikation mit dem Rekorder 
 Kommunikation über direktes RS232-Kabel 3 

  3-31 

9. Klicken Sie mit der rechten Maustaste auf die neue Verbindung, und klicken Sie 
dann auf Eigenschaften (Properties). 

 
g_vistanetworkproperties.bmp 

10. Öffnen Sie die Registerkarte Optionen (Options), und aktivieren Sie die 
Kontrollkästchen, wie unten dargestellt. 

 
g_vistanetworkoptions.bmp 
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11. Öffnen Sie die Registerkarte Netzwerk (Networking). Klicken Sie auf 
Internetprotokoll Version 4 (TCP/IPv4) (Internet Protocol Version 4 
(TCP/IPv4)), und klicken Sie dann auf Eigenschaften (Properties). 

 
g_vistanetworknetworking.bmp 

12. Klicken Sie auf Erweitert... (Advanced...). 

 
g_vistanetworkipv4properties.bmp 
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13. Deaktivieren Sie Standardgateway für das Remotenetzwerk verwenden (Use 
default gateway on remote network), und klicken Sie dreimal auf OK, um die 
Fenster Erweitert (Advanced), IPv4-Eigenschaften (IPv4 Properties) und 
Eigenschaften (Properties) der neuen Verbindungen zu schließen. 

 
g_vistanetworkipv4propertiesadvanced.bmp 
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14. Wenn Sie den Rechner nach dem Ändern der Baudrate nicht neu gestartet haben, 
sollten Sie ihn jetzt neu starten. Wechseln Sie nach dem Neustart zu 
Systemsteuerung > Netzwerk und Internet > Netzwerk- und Freigabecenter 
(Control Panel > Network and Internet > Network and Sharing Center), und 
klicken Sie auf Netzwerkverbindungen verwalten (Manage network 
connections), wie oben beschrieben.  

Fahren Sie fort, wie in „Überprüfung der seriellen Direktverbindung“ 
beschrieben. Wenn das Fenster Netzwerkstandort festlegen (Set Network 
Location) angezeigt wird, klicken Sie auf Abbrechen (Cancel). 

 
g_vistanetworklocation.bmp 



 Kommunikation mit dem Rekorder 
 Kommunikation über direktes RS232-Kabel 3 

  3-35 

Überprüfung der seriellen Direktverbindung 
1. Schließen Sie den Rekorder mit dem roten RS232-Nullmodemkabel an den seriellen 

Port Ihres Computers an.  

2. Gehen Sie zu Netzwerkverbindungen (Network Connections), und bauen Sie die 
neu erstellte Einwahlverbindung auf. 

 
g_ncc_serial.bmp 

3. Verfolgen Sie den Verlauf im Statusfenster. 

 
g_connection_serial.bmp 
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4. Nachdem Sie kontrolliert haben, dass die Verbindung funktioniert, trennen Sie sie 
wieder (Disconnect). 

 
g_ncd_serial.bmp 

Verbindung mit dem Rekorder 
1. Starten Sie PQ Analyze. 

2. Wählen Sie die Optionsfolge Übertragen > FLUKE 1760 > Serielle 
Verbindung (Übertragen > FLUKE 1760 > Serial Port). 

 
g_recorderconnect.bmp 

Hinweis 
Verwenden Sie unter Windows Vista Übertragen > Fluke 1760 > Modem 
(Übertragen > Fluke 1760 > Modem), um eine Verbindung mit dem 
Rekorder herzustellen. 
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3. Klicken Sie auf Verbinden (Connect). 

 
g_rs232.bmp 

 

4. Die Verbindung wird aufgebaut, und die Software kommuniziert mit dem Gerät. 
Überprüfen Sie dies, indem Sie den Status in der unteren rechten Ecke des 
Hauptfensters von PQ Analyze kontrollieren. 

 
g_ce.bmp 

Kommunikation mit Modems 

Herstellung der Modem-Netzwerkverbindung in Windows Vista. 

Hinweise 
• Vor Einrichten der Verbindung müssen Sie erst Ihr Modem in 

Windows installieren. (folgen Sie dabei bitte den Anweisungen des 
Modemherstellers). 

• Die Modemverbindung verwendet das PPP-Protokoll.  

Fahren Sie fort, wie in „Festlegen der Baudrate“ im Abschnitt „Erstellen der direkten 
seriellen Verbindung unter Windows Vista“ beschrieben. 

Herstellung der Modem-Netzwerkverbindung unter Windows XP. 

Hinweis 
Vor Einrichten der Verbindung müssen Sie erst Ihr Modem in Windows 
installieren. (folgen Sie dabei bitte den Anweisungen des 
Modemherstellers). 

Hinweis 
Die Modemverbindung verwendet das PPP-Protokoll.  
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1. Öffnen Sie in der Windows-Systemsteuerung (Control Panel) die 
Netzwerkverbindungen (Network Connections). 

 
g_screen9.bmp 

2. Starten Sie den Netzwerk-Installationsassistenten (New Connection Wizard), 
oder wählen Sie Datei > Neue Verbindung (File > New Connection). 

 
g_screen0.bmp 
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3. Klicken Sie auf Weiter (Next). 

 
g_connectionwizard_1.bmp 

4. Wählen Sie Mit dem Netzwerk an meinem Arbeitsplatz verbinden (Connect 
to the network at my workplace), und klicken Sie auf Weiter (Next). 

 
g_ncc1.bmp 
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5. Wählen Sie die Option Einwahlverbindung (Dial-up connection), und klicken 
Sie auf Weiter (Next). 

 
g_nccd.bmp 

6. Geben Sie einen Namen für die Verbindung ein, und klicken Sie auf Weiter 
(Next). 

 
g_ncwm.bmp 
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7. Geben Sie die Telefonnummer Ihres Geräts ein, oder lassen Sie das Feld leer, 
und klicken Sie auf Weiter (Next). 

 
g_ncwp.bmp 

8. Klicken Sie nochmals auf Weiter (Next). 

 
connectionwizard_7.bmp 
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9. Klicken Sie auf Fertigstellen (Finish). 

 
g_ncwc.bmp 

10. Gehen Sie zu Netzwerkverbindungen (Network Connections), und öffnen Sie 
das Eigenschaftsfenster für die neue Verbindung. 

 
g_ncp.bmp 
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11. Öffnen Sie die Registerkarte Optionen (Options). Aktivieren/Deaktivieren Sie 
alle Kontrollkästchen, wie unten abgebildet. 

 
mp.bmp 

12. Wählen Sie in der Netzwerk-Registerkarte (Networking) die Option 
Internetprotokoll (TCP/IP) (Internet Protocol (TCP/IP)), und klicken Sie auf 
Eigenschaften (Properties). 

 
mp1.bmp 
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13. Wählen Sie Erweitert (Advanced), deaktivieren Sie die Option Standard-
Gateway auf Remote-Host verwenden (Use default gateway on remote host), 
und klicken Sie anschließend auf OK. 

 
ipo.bmp 

14. Schließen Sie alle Einstellungsfenster mit OK. 

 
atsu.bmp 
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Überprüfung der Modem-Netzwerkverbindung 

Hinweis 
Falls Sie noch keine Telefonnummer angegeben haben, müssen Sie dies nun 
tun (über das mit der rechten Maustaste aufzurufende Kontextmenü 
Eigenschaften (Properties)). 

1. Schließen Sie ein Modem an das Gerät an und eins an Ihren PC. 

2. Gehen Sie zu „Netzwerkverbindungen“ (Network Connections), und bauen Sie 
die neu erstellte Einwahlverbindung auf. 

 
g_ncc_modem.bmp 

3. Verfolgen Sie den Verlauf im Statusfenster. 

 
g_connection_modem.bmp 
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4. Nachdem Sie kontrolliert haben, dass die Verbindung funktioniert, trennen Sie 
sie wieder (Disconnect). 

 
g_nccd.bmp 

Verbindung mit dem Rekorder 
1. Starten Sie PQ Analyze. 

2. Wählen Sie die Optionsfolge Übertragen > FLUKE 1760 > Modem (Transfer 
> FLUKE 1760 > Modem). 

 
recorderconnect_m.bmp 
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3. Übernehmen Sie die voreingestellte Telefonnummer (wie sie in der 
Einwahlverbindung definiert ist), oder ändern Sie sie, und klicken Sie anschließend 
auf Verbinden (Connect). 

 
mc.bmp 

4. Die Verbindung wird aufgebaut, und die Software kommuniziert mit dem Gerät. 
Überprüfen Sie dies, indem Sie den Status in der unteren rechten Ecke des 
Hauptfensters von PQ Analyze kontrollieren. 

 
cv.bmp 
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Startoptionen 
In manchen Umgebungen ist die Kommunikation zwischen dem PC und dem Rekorder 
so langsam, dass bei einer spezifischen Pinganforderung beim Setup der Verbindung ein 
Timeout auftritt. Die Pinganforderung kann auch durch eine Firewall blockiert werden. 
Starten Sie in diesem Fall PQ Analyze mit der Option /noping (der Nachteil besteht 
darin, dass Verbindungsprobleme später aufgespürt werden). 

1. Klicken Sie auf Start, navigieren Sie zu dem Eintrag für PQ Analyze, klicken Sie mit 
der rechten Maustaste darauf, und wählen Sie Verknüpfung erstellen (Create 
Shortcut) aus. 

 
startcreateshortcut.bmp 
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2. Klicken Sie mit der rechten Maustaste auf den neuen Eintrag, und wählen Sie 
Eigenschaften (Properties) aus. 

 
startcreateshortcutproperties.bmp 

3. Auf der Registerkarte Allgemein (General) können Sie eine neue Bezeichnung 
eingeben. Hängen Sie auf der Registerkarte Verknüpfung (Shortcut) /noping an das 
Feld Ziel (Target) getrennt durch ein Leerzeichen an. 

 
g_startproperties.bmp 
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Firewalls 
Wenn Sie über eine Firewall mit dem Rekorder kommunizieren möchten, müssen Sie die 
Firewall so einrichten, dass sie Kommunikation zulässt. Bei Problemen mit den 
Einstellungen der Firewall wenden Sie sich an den Netzwerkadministrator. 

In Tabelle 3-1 werden die für die Kommunikation zwischen dem Rekorder und PQ 
Analyze verwendeten Ports aufgeführt. 

Wenn eine Verbindung bei Verwendung eines Routers oder eines Gateways mit einer 
Firewall hergestellt werden soll, konfigurieren Sie das Gerät wie dargestellt. 

Tabelle 3-1. Kommunikationsports 

Protokoll Port Beschreibung Firewall 

UDP 30000 

Dieser Port dient dazu, 
Anforderungen vom Typ 
Geräte suchen (Search 
Devices) von PQ Analyze zu 
überwachen. Außerdem wird 
er bei Firmware-Updates 
verwendet. An diesen Port 
wird regelmäßig ein „Ping“-
Signal gesendet, um 
festzustellen, ob der 
Rekorder verfügbar ist.  

Wenn sich der Rekorder hinter einer 
Firewall befindet, muss dieser Port nur für 
Firmware-Updates geöffnet werden. 
Geräte suchen (Search Devices) 
verwendet Broadcasts, und Broadcasts 
passieren normalerweise keine 
Router/Firewalls.  

TCP 30000 
Dieser Port dient zum 
Empfangen von Befehlen 
von PQ Analyze.  

Wenn sich der Rekorder hinter einer 
Firewall befindet, muss dieser Port für die 
Kommunikation mit dem Rekorder geöffnet 
werden.  

TCP 30001 
Dieser Port dient zum 
Empfangen von Firmware-
Updates.  

Wenn sich der Rekorder hinter einer 
Firewall befindet, muss dieser Port nur für 
Firmware-Updates geöffnet werden.  

TCP 30002 
Dieser Port wird für die 
Übertragung von Binärdaten 
verwendet.   

Wenn sich der Rekorder hinter einer 
Firewall befindet, muss dieser Port nur 
geöffnet werden, wenn Daten vom 
Rekorder abgerufen werden sollen.  

TCP 22 (ssh) 
Dieser Port wird für 
ssh/erweiterte Einstellungen 
verwendet.  

Wenn sich der Rekorder hinter einer 
Firewall befindet, muss dieser Port nur 
geöffnet werden, wenn der Menüeintrag 
Erweiterte Einstellungen (Advanced 
Settings) der Software verwendet werden 
soll.  

ICMP 
Echoanforderung/-
antwort 

Dieses Protokoll wird von PQ 
Analyze während des 
Verbindungsaufbaus 
verwendet.  

Wenn sich der Rekorder hinter einer 
Firewall befindet, muss dieser Port für die 
Kommunikation mit dem Rekorder geöffnet 
werden. Alternative Vorgehensweise: 
Starten Sie das Programm mit dem 
Befehlszeilenparameter /noping. 
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Beheben von Kommunikationsstörungen  
Wenn Sie keine Verbindung mit dem Rekorder herstellen können, weil die IP-Adresse 
der Ethernet-Schnittstelle des Rekorders nicht bekannt ist, können Sie versuchen, eine 
Verbindung über die serielle Schnittstelle aufzubauen oder die Informationen durch 
dieses Verfahren beziehen: 

1. Schließen Sie ein USB-Flashlaufwerk oder eine CF-Karte an den Rekorder an. 

2. Warten Sie, bis die LED der CF-Karte ausgeschaltet wird, nachdem der 
abgeschlossene Datentransfer durch Blinken angezeigt wurde. Die LED kann statisch 
eingeschaltet bleiben, wenn nicht genügend Speicher zum Kopieren aller Daten 
vorhanden ist. 

3. Entfernen Sie das USB-Flashlaufwerk oder die CF-Karte, und schließen Sie das 
Laufwerk bzw. die Karte zum Lesen der Daten an einen PC an. 

4. Öffnen Sie die Datei JJJJ.MM.TT-hh-mm-ss_transfer.log im Ordner 
(Drive):\measurement_data\Serialnumber (of F1760).Name 

 
g_transfer_log.bmp 
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Beispiel für den Inhalt der Datei „transfer.log“: 

Ethernet configuration: 

dhcp 192.168.0.225 255.255.255.0 192.168.0.1 

 

fs_stat.f_bsize is 4096, fs_stat.f_bavail is 100883 

*pStorageSize is 393216 kB, pFilePath is 

/mnt/t2kextmem/sda1/measurement_data/UN57953.UN57953/tmpDownloading a measurement settings from 

the instrument 127.0.0.1. 

t1k_get_def_name reply: OK tma3xt2.def 

17712 

 

 EN: range 1 -     166  record size     730 B  complete collection data size     121180 B      0 MB 

No data for collection TD. 

 TL: range 1 -    1664  record size   10352 B  complete collection data size   17225728 B      16 MB 

TSH: range 1 -     166  record size   11232 B  complete collection data size    1864512 B      1 MB 

CUT: range 1 -      43  record size      28 B  complete collection data size       1204 B      0 MB 

TVS: range 1 -      95  record size    9656 B  complete collection data size     917320 B      0 MB 

 MW: range 1 -    4000  record size     344 B  complete collection data size    1376000 B      1 MB 

TRG: range 1 -   38912  record size      48 B  complete collection data size    1867776 B      1 MB 

 TN: range 1 -  524288  record size      32 B  complete collection data size   16777216 B      16 MB 

Collection RND does not exist. 

 

5. Die unter „Ethernet-Konfiguration:“ (Ethernet configuration) aufgeführten Daten 
umfassen bis zu vier Felder: 

<Modus> (mode) <IP-Adresse> (IP address) <IP-Subnetzmaske> (IP subnet 
mask) <IP-Gateway> (IP gateway) 

<Modus> (mode) kann entweder „dhcp“, „statisch“ (static) oder „deaktiviert“ 
(disabled) sein; 

<IP-Adresse> (IP address) ist nur in zwei Fällen vorhanden: 

1. Im Modus „static“ (statisch) zeigt sie die durch die Konfiguration Service > 
Advanced Settings (Erweiterte Einstellungen) dem Rekorder zugewiesene 
Adresse an. 

2. Im Modus „dhcp“, wenn eine Verbindung durch ein Netzwerkkabel mit 
einem PC-Host oder einem Switch besteht. Sie zeigt entweder die durch den 
DHCP-Server zugewiesene Adresse des Rekorders oder die selbst 
zugewiesene Adressse (169.254.xx.yy) an, wenn während des Timeouts (ca. 
1 Minute) kein DHCP-Server gefunden wurde. 

<IP-Subnetzmaske> (IP subnet mask) und <IP-Gateway> (IP gateway) sind im 
<statischen> (static) Modus und im aktiven <dhcp>-Modus dargestellt. 

Für <dhcp> ohne Verbindung und <deaktiviert> (disabled) ist nur der 
<Modus> (mode) dargestellt. 

Im obigen Beispiel: 

• Das erste Feld stellt den Modus für das Beziehen der IP-Adresse dar (in 
diesem Fall war der DHCP-Server verfügbar).  

• Die ersten vier Zahlen stellen die IP-Adresse des Rekorders dar: 
 192.168.0.225 

• Die nächsten vier Zahlen stehen für die Subnetzmaske:    
 255.255.255.0 

• Und die letzten vier Zahlen sind die Gateway-Adresse:   
 192.168.0.1 
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Kapitel 4 
PQ Analyze Übersicht 

Startmenü 
Nach Start des Programms erscheint das Start Menü (Start Menu). 

 
g_Startup.bmp 

Optionen im Offline-Modus 
• Gespeicherte Daten (Recorded Data) öffnet aufgezeichnete Messdaten zur 

Auswertung. 

• Setup Offline ermöglicht Geräteeinrichtung, ohne dass ein Gerät angeschlossen 
ist. 
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Optionen im Online-Betrieb (Live Mode) 
• Setup dient der Konfiguration eines an den PC angeschlossenen Geräts.  

• Online dient der Überprüfung von Einstellungen und Messbereichen. 

• Download ruft im Gerät gespeicherte Daten ab. 

Dieses Dialogfenster kann durch Markieren der entsprechenden Option deaktiviert 
werden. In diesem Fall startet PQ Analyze mit einem leeren Bildschirm. 

Hauptauswertefenster 
Wenn Sie Daten von Ihrem Gerät herunterladen oder eine Messdatendatei zur 
Auswertung öffnen, beginnen Sie Ihre Analyse immer im Hauptauswertefenster. 

 
g_mainanalysiswindow.bmp 
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Virtuelle Geräte 
Auf der linken Seite des Hauptauswertefensters befinden sich mehrere Schaltflächen, die 
die so genannten „virtuellen Geräte“ repräsentieren. Jedes davon kann als individuelles 
Gerät angesehen werden, das eine bestimmte Funktion erfüllt. Die Idee ist, mehrere 
dieser unterschiedlichen Messgeräte in Software zu realisieren (virtuell) und in einem 
kompakten Gehäuse zu vereinigen. Das Gerät ist daher in der Lage, unterschiedlichste 
Messaufgaben parallel durchzuführen.   

Generell kommunizieren virtuelle Messgeräte besser miteinander als physikalisch 
getrennte Einheiten. So können Ergebnisse eines Gerätes die Aufzeichnung von Daten 
durch andere Geräte steuern. Alle Messergebnisse werden dabei zeitsynchron abgetastet 
und aufgezeichnet. 

Im oberen Bereich des Fensters werden Start- und Endzeit der Messkampagne sowie der 
Zeitunterschied angezeigt.  

Die Zoom- und Verschieben-Funktionen helfen bei der Auswahl des korrekten 
Zeitbereichs für die Analyse. 

Hauptprogrammfenster 
Das Hauptprogrammfenster enthält die Menüleiste, die Haupt-Werkzeugleiste und die 
Statusleiste im unteren Bereich.  

Nähere Angaben zum Menü finden sich in Kapitel 8 „Menüreferenz“.  

Die Werkzeugleiste enthält die unten aufgeführten Symbole: 

       

Taste Funktion 

 
Mit „Datei/Neu“ (File/New) wird eine neue Messung konfiguriert. 

 
Mit „Datei/Öffnen“ (File/Open) wird eine vorhandene Messdefinition oder 
Messdatendatei geöffnet. 

 
Mit dieser Funktion wird der aktuelle Bildschirminhalt auf dem Systemdrucker 
ausgedruckt. 

 
Diese Schaltfläche öffnet das Hauptauswertefenster nach der Übertragung von 
Messdaten. 

 
Wenn eine Verbindung zwischen Gerät und PC hergestellt ist, wird mit dieser 
Schaltfläche die Übertragung der Messdaten auf den PC gestartet. 

 
ASCII-Reportgenerator – Daten in Textformat 

 
EXCEL-Reportgenerator: erstellt automatisch Messberichte basierend auf der Export-
Konfiguration 
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Die Statusleiste zeigt nützliche Informationen zu Ihrer Messung und Ihrem Rekorder an. 

Auf der linken Seite ist der Speicherort der Daten auf Ihrem PC angegeben, auf der 
rechten Seite finden sich Informationen zum angeschlossenen Gerät und die 
Verbindungsstatus-LED (grün=angeschlossen, rot=nicht angeschlossen, gelb= Netzwerk 
wird durchsucht). Klicken Sie auf die LED. 

 
g_mainwindowstatusbar.bmp 

 Hinweis 
Vor Verwendung der LED-Anzeigen und des ONLINE-Modus muss Fluke 
1760 konfiguriert werden. Ein neues Gerät ist noch nicht konfiguriert. 
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Kapitel 5 
Einrichten von Messungen 

Haupteinstellungsfenster 

Hinweis 
Sollten die Software am PC und im Gerät unterschiedliche Versionen 
haben, ist ein Update zu empfehlen. Bei unterschiedlichen Versionen der 
Software kann der Rekorder nicht konfiguriert werden. 

Das Haupteinstellungsfenster ist der Ausgangspunkt für die Konfiguration der 
Messkampagne. Die Standardwerte aller Einstellungen werden der in der Titelleiste 
angegebenen Messdefinitionsvorlage entnommen (.vdf). Die Standardvorlage kann mit 
der Optionsfolge Optionen > Default Def-Datei (Options > Default Def-File) 
ausgewählt werden. 

In der Tabelle lassen sich Metainformationen über Ihre Messkampagne eingeben. Alle 
Felder können per Doppelklick bearbeitet werden. Die vorhandenen Felder (Firma, 
Abteilung, usw.) sind lediglich Vorschläge, die geändert werden können. 

Geben Sie mithilfe der Schaltflächen auf der rechten Seite die spezifischen 
Einstellungsdialoge ein (Details siehe unten).  

Mit den Aktionsschaltflächen im unteren Bereich des Fensters lassen sich folgende 
Aufgaben durchführen: 

• Initialisieren (Initialize): sendet die Messungseinstellungen zum Rekorder (muss 
angeschlossen sein) 

• Speichern (Save): speichert die Messungseinstellungen in einer neuen vdf-Datei als 
Vorlage 

• Schließen (Close): schließt den Einstellungsdialog. 

1. Mit Datei/Neu (File/New) oder durch Klicken auf  wird eine neue 
Messdefinitionsdatei (.def) erstellt.  
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g_mainsettingswindow.bmp 

2. Eine existierende Vorlage (*.vdf) kann über Datei > Öffnen (File > Open) 
geöffnet werden. 

3. Ändern Sie alle Einstellungen entsprechend Ihren Anforderungen.  

4. Speichern Sie die Konfiguration als Vorlage, und bzw. oder initialisieren Sie die 
Messung. 

Hinweis 
Für erste Prüfmessungen ist zu empfehlen, die Standardwerte für alle 
Einstellungen zu übernehmen. Anhand der ersten Messergebnisse können 
danach gezielt die besten Triggereinstellungen bestimmt werden. 

Hardware-Einstellungen (Hardware Settings) 
In diesem Dialogfeld können Sie alle Hardwareparameter einstellen. Das Messsystem 
(Input Configuration) bestimmt, wie die den Eingangskanälen zugeführten Signale vom 
Gerät interpretiert werden. Das Messsystem kann daher auch als 
„Eingangskonfiguration“ bezeichnet werden. Nähere Informationen zu den unterstützten 
Messsystemen finden Sie im Benutzerhandbuch. 

Es gibt zwei weitere Optionen in Bezug auf die Eingangskonfiguration. Wenn Sie die 
Option Strom: IL3 = - IL1 - IL2 (Current: IL3 = - IL1 - IL2) aktivieren, wird der Strom 
auf Kanal 3 nicht gemessen, sondern berechnet. Die Hauptanwendung ist ein Dreileiter-
Messsystem mit nur zwei Stromwandlern, wobei die Summe der Dreiphasenströme 
gleich null ist. In diesem Fall können Sie den dritten Strom berechnen.  

Die zweite Option legt fest, welche Spannungen als Quelle für die Erfassung von 
Ereignissen und die Messung von Flicker und Oberschwingungen verwendet werden. 
Wenn das Kontrollkästchen aktiviert ist, werden die Parameter auf Grundlage der 
Dreieckspannungen anstatt auf Grundlage der Sternspannungen ausgewertet.  
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g_hardwaresettings.bmp 

Der Abschnitt Analog enthält Felder zur Auswahl der passenden Sensorbereiche. Die 
Felder Messgröße (Quantity) geben an, welche Signale der Rekorder an den 8 
Eingangskanälen erwartet (dies hängt vom gewählten Messystem (Input Configuration) 
ab). Die Einstellung Messbereich (Range) sollte nur dann verwendet werden, wenn ein 
fixer Messbereich gewünscht ist. Ansonsten ist sie im Automatikmodus zu belassen. Die 
meisten Stromsensoren unterstützen zwei Messbereiche. Wenn Sie diese Stromeingänge 
auf „Auto“ setzen, wird automatisch der größere Bereich gewählt. Die Einstellung 
Skalierung (Scaling) dient zur Unterstützung Ihrer Spannungs- und Stromwandler. Es 
handelt sich dabei um einen aus der Division der Primärspannung durch die 
Sekundärspannung berechneten Faktor. Sie können jeden einzelnen Kanal für die 
Messung von AC oder DC gekoppelt konfigurieren.  

Hinweis 
Gleichstromkopplung ist nur für Sensoren verfügbar, die dies unterstützen. 
Wenn einer der Eingänge auf DC-Modus gesetzt ist, weist die 
Messkampagne Lücken auf. Das heißt, alle 10 Minuten fehlt ein Interval 
von 200 ms, da der Gleichspannungsoffset gemessen wird, um die 
Offsetdrift auszugleichen. Um eine Messkampagne nach der Norm IEC 
61000-4-30 Ed.2 durchzuführen, die lückenlose Messungen verlangt, sind 
alle Kanäle „AC“ zu setzen.  
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Nenn- und Grenzwerte  
Diese Dialogfelder bieten Ihnen die Möglichkeit, die Nennwerte Ihres Stromnetzes, die 
Schwellwerte für die Ereigniserfassung und die Grenzwerte für die statistische 
Auswertung (nach EN50160) zu ändern. 

Un – fn – IL (Vn – fn – IL) 
Geben Sie die Nennspannung Ihres Stromnetzes ein. Je nach gewähltem Messsystem 
(siehe auch „Hardware-Einstellungen (Hardware Settings)“) können Sie entweder die 
Sternspannung (Un) oder die Dreieckspannung (Un ph-ph) angeben. Wenn Sie 
Spannungswandler in Ihrer Messkette haben, geben Sie den Nennwert der realen 
Primärspannung ein, und passen Sie den Parameter Skalierung (Scaling) im Dialogfeld 
Hardware-Einstellungen (Hardware Settings) an. Gemäß IEC 61000-4-30 Ed. 2 
entspricht dies der eingegebenen Eingangsspannung Uc. 

 
g_nominalandlimits_vif.bmp 

Geben Sie die nominale Netzfrequenz (fn) ein. 

Geben Sie den Spitzenlaststrom IL ein.  

Dieser Parameter ist erforderlich für die Berechnung des Gesamtverzerrungsfaktors TDD 
(Total Demand Distortion).  
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D-S-I 

 
g_nominalandlimits_dsi.bmp 

Die Erfassung von Ereignissen (Unterspannung, Überspannung, Unterbrechungen, 
schnelle Spannungsschwankungen) basiert auf Halbwellen-Effektivwerten oder 
Vollwellen-Effektivwerten, die einmal pro Halbwelle aktualisiert werden (entsprechend 
der Konfiguration durch die Einstellung Die Auswertung erfolgt mit (Dips, swells and 
interruptions based on)). 

Die Schwellen beziehen sich auf die Nominalspannung Un. 

Legen Sie die Schwellwerte für Unterspannung und Überspannung fest.  

Die Norm IEC 61000-4-30 Ed. 2 empfiehlt eine Hysterese von 2 %. Sie kann mit einem 
Wert von 0 % abgeschaltet werden. Der Hysteresewert wird zum voreingestellten 
Schwellwert hinzuaddiert. 

Beispiel: 

Ist die Hysterese auf 2 % gesetzt, liegt der Schwellwert für den Beginn von 
Spannungseinbrüchen bei 90 % von Un und der Schwellwert für das Ende der Einbrüche 
bei 92 % von Un. Für Spannungsspitzen lauten die Grenzwerte 110 % und 108 % und für 
Unterbrechungen 1 % und 3 %. 
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Die Abbildung zeigt, wie die Dauer von Ereignissen bestimmt wird. 

Die Grenze Kurzunterbrechung / Unterbrechung (Short / long interruption time 
threshold) definiert die Grenze zwischen kurzen Unterbrechungen (im Allgemeinen <3 
Min.) und langen Unterbrechungen. Kurze und lange Unterbrechungen werden in der 
Ereignisliste separat aufgeführt. 

Aktivieren Sie Flagging durch Wahl der Option Flagging anwenden (Apply flagging 
concept). Flagging bedeutet, dass im Fall von Unterspannungen, Überspannungen und 
Unterbrechungen alle anderen beeinflussten Größen wie Frequenz, Oberschwingungen 
oder Flicker in der statistischen Auswertung unterdrückt werden, um Mehrfachzählungen 
zu vermeiden.  

Ist diese Option aktiv, findet das Flaggingkonzept der Norm IEC 61000-4-30 Ed. 2 Punkt 
4.7 Anwendung. 

Hinweis 
Nach der Aufzeichnung kann das Flagging nicht verändert werden, d. h. es 
werden keine „geflaggten“ Daten aufgezeichnet, sondern nur Ereignisse. 

Eine gleitende Referenz wird verwendet, wenn die Nennspannung freier schwanken 
kann. Dies ist im Allgemeinen in Hochspannungssystemen der Fall. Bei Anwendung der 
gleitenden Referenz werden Unterspannungen und Überspannungen auf Basis einer 
Spannungsänderung relativ zur tatsächlichen Effektivspannung anstatt anhand der 
absoluten Nennspannung erfasst. Ist diese Option aktiv, findet die gleitende Referenz 
gemäß IEC 61000-4-30 Ed. 2 Punkt 3.29 und 5.4.4 Anwendung. 
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EN50160 
In diesem Abschnitt legen Sie die Grenzwerte für die statistische Auswertung der 
Spannungsmessung fest. 

 
g_nominalandlimits_en50160.bmp 

Langsame Spannungsänderungen werden oft durch Lastschwankungen im Verteilernetz 
verursacht. Geben Sie die Limits für 95 % und für 100 % der Messzeit ein. Die 
Auswertung basiert auf den Mittelwerten für 10 Min.  

Schnelle Spannungsänderungen werden oft durch Schalten unter Last im Verteilernetz 
verursacht. Geben Sie den Grenzwert für 95 % der Messzeit ein. Die Auswertung basiert 
auf Halbwellen-Effektivwerten oder Vollwellen-Effektivwerten, die einmal pro 
Halbwelle aktualisiert werden (entsprechend der Konfiguration im D-S-I-Dialogfeld).   

Geben Sie die Netzfrequenzgrenzwerte für 95 % und für 100 % der Messzeit ein.  

Beachten Sie bitte, dass sich in unsynchronisierten „Inselnetzen“ die Klasse für 
Frequenzschwankungen unterscheidet: 95 % anstatt 99,5 % der Messperiode für 
verbundene Systeme. Es wird eine Auswahl angeboten. 

Spannungsschwankungen beeinflussen die Leuchtdichte von Beleuchtungssystemen, 
wodurch das als Flicker bekannte optische Phänomen hervorgerufen werden kann. Der 
Grenzwert für den Langzeitflicker Plt ist in der Norm EN50160 als 1.0 definiert. Dies 
entspricht der optischen Wahrnehmungsgrenze.  



1760 
Referenzhandbuch 

5-8 

Die höchstzulässige Anzahl von Spannungsereignissen (Unterspannungen, 
Überspannungen und Unterbrechungen) wird hier definiert. Diese Zahl dient im 
EN50160-Übersichtdiagramm zur Skalierung der Ereignisleistenhöhe. 

Zur Unsymmetrie kommt es, wenn das dreiphasige Spannungssystem nicht symmetrisch 
ist (d. h. wenn die Phasenwinkel vom Nennwert 120° abweichen oder die 
Größenordnungen der Phasenspannungen sich voneinander unterscheiden).  

Dies ist der Grenzwert für 95 % der 10-Minuten-Werte während der Messperiode. 

EN50160 hxx 

 
g_nominalandlimits_enhxx.bmp 

Harmonische (Oberschwingungen) sind Komponenten der Versorgungsspannung, deren 
Frequenz ein ganzzahliges Vielfaches der Grundschwingung der Netzspannung ist. Ein 
Grenzwert kann jeder Harmonischen 2. bis 25. Ordnung zugewiesen werden, 
einschließlich THD (total harmonic distortion). Die statistische Auswertung der 
Oberschwingungen basiert auf den Mittelwerten für 10 Min.  

Schnelle Spannungsänderungen (Rapid Voltage Changes) 
Schnelle Spannungsänderungen sind kurzfristige Übergänge von einem stabilen Zustand 
in den anderen. Der „Grenzwert für minimale Konstanthaltung“ (Steady voltage 
tolerance) definiert die zulässige Abweichung für einen stabilen Zustand. Die Spannung 
muss mindestens über die „Minimale Dauer der Konstanthaltung“ (Minimum steady 
time) innerhalb des Toleranzbereichs verbleiben, damit der Zustand als stabil bezeichnet 
werden kann. Die „Minimale Spannungsdifferenz“ (Minimum Voltage difference) ist der 
erforderliche minimale Spannungssprung, der eine schnelle Spannungsschwankung 
auslöst. Die Spannungsdifferenz wird entweder aus zwei aufeinanderfolgenden stabilen 
Zuständen oder aus dem Unterschied zwischen den Maximalwerten der instabilen 
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Periode und dem stabilen Zustand berechnet. Letzeres entspricht der norwegischen FoL-
Anforderung. Wählen Sie das gewünschte Verhalten mit der Einstellung 
Mindeständerungsgeschwindigkeit basierend auf (Minimum Voltage difference based 
on). Die Mindeständerungsgeschwindigkeit wird als % von Un pro Sekunde ausgedrückt 
und gibt die Geschwindigkeit der Spannungsänderung an. Sie wird berechnet durch 
Division der Spannungssprunggröße zwischen zwei stabilen Zuständen durch die Dauer 
der instabilen Periode (dies ist der Zeitraum zwischen dem Ende des stabilen Zustands 1 
und dem Beginn des stabilen Zustands 2).   

Die Erfassung schneller Spannungsschwankungen basiert auf Halbwellen-Effektivwerten 
oder Vollwellen-Effektivwerten, die einmal pro Halbwelle aktualisiert werden 
(entsprechend der Konfiguration im D-S-I-Dialogfeld).  

 
g_rapidvoltagechangessettings.bmp 

Die Parameter sind empfohlen in der Norm IEC 61000-4-30 Ed. 2, Punkt 5.11 und A5. 
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CBEMA-Darstellung  
In der „CBEMA-Darstellung“ können die zulässigen Toleranzen für die 
Ereignisbewertung nach CBEMA oder ANSI geprüft bzw. abgeändert werden. Diese 
Grenzwertkurven wurden vom CBEMA (Computer and Business Equipment 
Manufacturers Association) erstellt und definieren die Beeinflussung von Geräten durch 
Spannungsereignisse in Abhängigkeit der Höhe und Dauer. Dies ermöglicht eine einfache 
Beurteilung der zu erwarteten Funktionsstörungen. 

Die Grenzkurven können mit der linken Maustaste ausgewählt und durch Verschieben 
der rot markierten Stützpunkte angepasst werden. Die Farbe und Breite der Kurven 
können nicht geändert werden. 

Die Taste Default stellt auf die Standardeinstellung zurück. 

 
g_cbema.bmp 
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Beginn / Ende (Start / Stop) 
In diesem Fenster können Beginn und Ende einer Messung eingegeben werden.  

 
g_start_stop.bmp 
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Speichermanagement (Memory Management) 
In diesem Dialogfeld können Sie die Verwendung des Rekorderspeichers konfigurieren. 

Bei kontinuierlichen Aufzeichnungen können Sie genau voraussagen, wie viele Daten pro 
Zeiteinheit gespeichert werden. Bei getriggerten Aufzeichnungen ist dies jedoch völlig 
unmöglich. Das Speichermanagement hat den Zweck, dediziert zugewiesenen 
Speicherplatz für spezielle virtuelle Geräte zu reservieren.  

• Für Kontinuierliche Aufzeichnungen (Continuous Recording) können Sie entweder 
die erforderliche Mindestlänge der Aufnahme wählen oder die Höchstmenge an 
Speicherplatz, die Sie aufwenden möchten (in % der gesamten Speicherkapazität). 

• Für Getriggerte Aufzeichnungen  (Triggered Recording) können Sie die Anzahl der 
zu speichernden einzeln ausgelösten Aufnahmen oder wiederum den prozentualen 
Anteil am Gesamtspeicher festlegen. 

• Mit der Einstellung Ereignisaufzeichnung (Event Recording) begrenzen Sie die 
Anzahl der Einträge im Ergebnisprotokoll.  

• Die kleine Aufwärtspfeil-Schaltfläche links neben der Speichereinstellung weist den 
gesamten verbliebenen freien Speicherplatz dem gewählten virtuellen Gerät zu. 

• Die Option Modus (Mode) schaltet zwischen linearem und zirkularem Modus um. 
Im linearen Modus wird die jeweilige Aufzeichnung beendet, wenn der reservierte 
Speicherplatz aufgebraucht ist. Im zirkularen Modus wird die Aufzeichnung 
fortgesetzt, wobei die jeweils ältesten Messdaten überschrieben werden (im Rekorder 
finden sich also immer die aktuellsten Daten). 

Wenn keine Verbindung zu einem Gerät besteht, können Sie die Größe der Speicherkarte 
im Rekorder über die Schaltfläche Speicher (Memory) wählen. 
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Hinweis 
Die ausgewählte Speichergröße muss der tatsächlich im Rekorder installierten Karte 
entsprechen, da sonst im Dialogfenster für das Speichermanagement falsche Daten 
angezeigt werden. 

 
g_memorymanagementsettings.bmp 
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Aufzeichnungsmodi (Recording Modes) 
In diesem Fenster können Aufzeichnungsdauer, Pretrigger und die Holdoff-Zeit für alle 
virtuellen Messgeräte festgelegt werden.  

 
g_recordingmodes.bmp 

Die Bedeutung der Parameter lässt sich der Grafik am oberen Rand des Dialogfelds 
entnehmen. Das Bild ändert sich dynamisch in Abhängigkeit von den Einstellungen und 
bezieht sich immer auf das ausgewählte virtuelle Gerät.  

Mit den zwei Kontrollkästchen im Bereich für kontinuierliche Aufzeichnungen können 
Sie ununterbrochene Messungen für Effektivwerte und Oberschwingungen wählen. Bei 
Aktivierung dieser Option beläuft sich die kürzeste effektive Mittelungszeit auf 200 ms.  

Bei der Transientenaufzeichnung kann die Abtastrate zwischen 100 kHz und 10 MHz 
eingestellt werden. Beachten Sie, dass die Aufzeichnungsdauer von der Abtastfrequenz 
abhängt. Die maximale Anzahl an Abtastwerten pro Aufnahme beträgt 262144. Dies 
entspricht einer maximalen Aufzeichnungsdauer von 2,62 s bei 100 kHz und 26,2 ms bei 
10 MHz.  

Nach der Einrichtung lässt sich die Darstellung im unteren Bereich des Dialogfelds von 
„Zeit“ (Time) auf „Messwerte / Samples“ (Values / Samples) umschalten, um die Anzahl 
der aufzuzeichnenden Werte zu kontrollieren.  

Hinweis 
Die Transientenoption muss eingebaut sein. Es erfolgt keine 
Fehlermeldung, wenn eine nicht zugelassene Abtastfrequenz ausgewählt 
wird. 
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Triggereinstellungen (Trigger Settings) 
Im Gegensatz zu den ständig aufgezeichneten kontinuierlichen Messungen werden die so 
genannten getriggerten Aufnahmen nur dann abgespeichert, wenn der entsprechende 
Trigger aktiviert und der Triggerschwellwert überschritten wird.  

Für jedes virtuelle Gerät des Typs getriggerte Aufnahme gibt es ein Dialogfeld zu 
Triggereinstellungen. Dies sind im Einzelnen: 

1. Effektivwerte (RMS) 

2. Oszilloskop (Oscilloscope) 

3. Transienten (Transient)  

4. Rundsteuersignal (Ripple Control Signal)  

5. Oberschwingungen (Harmonics) 

6. Zwischenharmonische (Interharmonics) 

7. Zeit (Time) 

Aktivieren Sie die Trigger durch einen Klick mit der rechten Maustaste in die 
entsprechenden Felder. 

Die Aufzeichnungen werden durchgeführt wie im Dialogfenster „Einstellungen 
Aufnahmemodi“ (Settings Recording Modes) definiert. 

 

Rote Anzeige: für diesen Trigger ist kein Schwellwert 
definiert.  

 

Grüne Anzeige: für diesen Trigger ist ein Schwellwert 
definiert.  

 

Von einem Ereignis können mehrere Triggerbedingungen erfüllt werden. Wir empfehlen 
nicht zu viele Trigger zu aktivieren, sondern jene über die entsprechende Checkbox 
auszuwählen, mit der sich das gesuchte Ereignis am besten finden lässt. 

Alle Aufnahmen werden entsprechend den Angaben im Dialogfeld Recording Modes 
(Aufnahmemodi) durchgeführt. 
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Effektivwerte (RMS) 

 
g_triggersettingsrms.bmp 

Dieser Trigger kann auf Phasenspannungen (U), Ströme (I), Dreieckspannungen (Up-p), 
die Frequenz (f) und Wirkleistungswerte (P) angewendet werden. 

Dies ist ein Trigger für schnelle Effektivwerte (10 ms bis zu 3 s Aggregation). 

Der Trigger spricht an, wenn die Messwerte die Grenzwerte überschreiten.   

Wählen Sie mit den Kontrollkästchen Effektivwerte (RMS) und Oszilloskop 
(Oscilloscope) die Aufnahmen, die Sie triggern möchten. 

 
g_rms-oscilloscope.bmp 

Es gibt Grenzen für Höchstwerte, Mindestwerte und die Unterschiede zwischen zwei 
Folgewerten. 

Einige typische Anwendungen:   

Erfassung von Spitzenwerten von Spannungen, Strömen und/oder Leistungswerten und 
Warnungen zum Abschalten schwerer Lasten zwecks Vermeidung von Spitzentarifen, 
wenn die Leistung definierte Spitzenwerte erreicht. 
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Erfassung von Spannungseinbrüchen – Die gleichzeitige Aufzeichnung von Spannungs- 
und Stromwerten liefert Daten, aus denen hervorgeht, ob Lastschwankungen in der 
Anlage den Spannungseinbruch verursacht haben oder ob die Spannungsabfälle auf 
andere Zweige des Verteilernetzes zurückzuführen sind. 

Erfassung von Änderungen im Verteilernetz – Es ist möglich, komplexe 
Triggereinstellungen vorzunehmen, sodass der Fluke 1760 immer die für die 
Problemlösung und Lokalisierung von Störungen relevanten Daten aufzeichnet: 

• Gibt es Spannungseinbrüche und Spannungsspitzen?  

• Wurden große Lasten aufgeschaltet, und haben sie Spannungseinbrüche 
produziert, die sich auf das Verteilernetz ausgewirkt haben?  

• Ist die Netzstromimpedanz am Verknüpfungspunkt ausreichend niedrig? 

• Überwachung externer Signale von Schutzrelais, industriellen 
Steuerungssystemen usw. 

• Trigger für Statusänderungen spezifischer externer Signale. 

 

Oszilloskop (Oscilloscope)  

 
g_triggersettingsosci.bmp 
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Diese Trigger lassen sich auf Phasen- und Nullleiterspannungen (U) sowie auf Phasen 
und Nullleiterströme (I) anwenden. Max und Kurventrigger können auch auf 
Dreieckspannungen (Up-p) angewendet werden. 

Die Grafik am oberen Rand des Fensters verdeutlicht die Bedeutung der Trigger. 

Wählen Sie mit den Kontrollkästchen Effektivwerte (RMS) und Oszilloskop 
(Oscilloscope) die Aufnahmen, die Sie triggern möchten. 

Es sind fünf Typen von unterschiedlichen Oszilloskoptriggern verfügbar: Pegel (Level), 
Sinus (Sine), Max, Phase und Kurve (Wave). 

Pegel (Level) ist vergleichbar mit dem Triggerlevel eines Oszilloskops. Positive 
(steigende) oder negative (fallende) Flanken werden vom Symbol links neben dem 
numerischen Eingabefeld bestimmt.  

Die Pegelüberschreitung (Level Trigger) wird für die präzise Untersuchung von 
kurzfristigen Spannungs- und Stromspitzenwerten verwendet. Es ist wichtig, passende 
Vortrigger-Zeiträume in den Aufnahmemodi (Recording Modes) zu definieren. Auf 
diese Weise können die Abläufe vor dem Ereignis und das Ereignis insgesamt detailliert 
analysiert werden. 

Der Trigger Sinus (Sine) reagiert auf Abweichungen von der idealen Sinuswelle. Auf der 
Grundlage von Nulldurchgängen und Amplituden des letzten Zyklus wird eine ideale 
Sinusschwingung berechnet. Ist die Abweichung der Abstastwerte der tatsächlichen 
Netzperiode von dieser idealen Sinuswelle größer als der Grenzwert, wird eine 
Aufzeichnung gestartet.  

Der Trigger Sinus (Sine) kann zur Erfassung von Kommutierungseinbrüchen, schnellen 
Spannungssenkungen und plötzlichen Wellenformverzerrungen verwendet werden. 

Der Trigger Max überwacht die Höchstwerte unabhängig von der Polarität. Er erfasst 
positive wie negative Spitzen. Er wird für die präzise Untersuchung von kurzfristigen 
Spannungs- und Stromspitzenwerten verwendet. 

Der Phasentrigger reagiert auf Phasensprünge zwischen aufeinanderfolgenden Zyklen. 
Die Nulldurchgänge benachbarter Perioden werden ausgewertet.  

Der Trigger Phase kann zur Erfassung von Überströmen oder Kurzschlüssen in 
benachbarten oder Hostnetzwerken verwendet werden. 

Der Trigger Kurve (Wave) überwacht die Wellenformunterschiede aufeinanderfolgender 
Netzperioden. Die Abtastwerte der letzten Periode werden mit denjenigen der aktuellen 
verglichen. Es handelt sich hierbei um einen universellen Trigger, der praktisch alle nicht 
stationären Phänomene einer bestimmten Größenordnung erfasst.  

Der Trigger Kurve (Wave) ist perfekt für alle Arten von Störungsanalysen und 
Fehlersuchen geeignet, da die meisten Netzqualitätsprobleme plötzliche 
Wellenformänderungen zur Folge haben. Anhand der aufgezeichneten Wellenformen 
lässt sich in den meisten Fällen die Störungsursache ermitteln: Schaltvorgänge von 
Kondensatorbänken, Kommutierungsverzerrungen, Schwingungen im Netz oder 
Erdschlüsse im Mittelspannungssystem weisen typische signifikante Wellenformen auf. 
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Transienten (Transient)  

 
g_triggersettingstransi.bmp 

Transienten sind kurze, unvorhergesehene Signale im Verteilernetz, die nur einmal 
auftreten und hohe Amplituden- und Anstiegsraten aufweisen. Sie enthalten 
Hochfrequenzkomponenten. Darum muss das Eingangssignal einen 1,5-kHz-
Hochpassfilter durchlaufen, bevor es der Triggerlogik zugeführt wird. Überschreitet der 
Spannungssprung den voreingestellten Wert Up, wird eine Aufzeichnung von 
Transienten, Effektivwerten und/oder Oszilloskopwerten  ausgelöst, je nach 
Einstellungen. 

Der Trigger ist aktiv für Spannungen in den Kanälen CH 1-CH 4, sofern die 
Transientenoption im Gerät installiert ist. 

Die Transientenoption ermöglicht Abtastfrequenzen zwischen 100 kHz und 10 MHz.  

Hinweis 
Bei Verwendung von Spannungswandlern wird die in den Hardware-
Einstellungen (Hardware Settings) definierte Skalierung berücksichtigt. 
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Rundsteuersignale (Ripple Control Signal)  

 
g_triggersettingsripple.bmp 

Dieser Trigger lässt sich auf Phasen- und Nullleiterspannungen sowie auf Phasen- und 
Nullleiterströme anwenden. Er bezieht sich auf Signale mit der vorgegebenen 
Mittenfrequenz (Center Frequency). 

Die 50/60-Hz-Frequenzkomponenten werden auf weniger als 1 % abgeschwächt.  
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Oberschwingungen (Harmonics) 

 
g_triggersettingsharmonics.bmp 

Oberschwingungen sind Signalkomponenten mit Frequenzen, die ganzzahlige Vielfache 
der Grundschwingungsfrequenz sind. 

Dieser Trigger lässt sich auf Spannungen, Ströme, Nullleiterspannungen und 
Nullleiterströme anwenden. 

Die Werte können absolut in V oder A oder relativ zur Grundschwingung ausgegeben 
werden. Das Einstellungsfenster verfügt über einen Grenzwerteditor zur schnellen und 
einfachen Einstellung aller Grenzwerte. Für Ströme gibt es einen gesonderten 
Störgrenzenberechner, der auf den „Technischen Regeln zur Beurteilung von 
Netzrückwirkungen (TOR)“ basiert (dabei handelt es sich um eine europäische 
Bestimmung). 

Hinweis 
THD ist der gesamte Anteil an Oberschwingungen. TID ist der gesamte 
Anteil an Zwischenharmonischen. Diese Funktion ermöglicht das Auffinden 
von zwischenfrequenten Störquellen, unabhängig davon in welchem 
Frequenzbereich diese Störsignale auftreten. Bei Ansprechen des TID-
Triggers können Momentanwerte aufgezeichnet werden. Aus der 
Spektralanalyse kann danach offline die Frequenz des Störsignals ermittelt 
werden. Mit dieser Funktion können Beeinflussungen von 
Rundsteuersignalen oder Leistungselektronik aufgefunden werden.  
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Zwischenharmonische (Interharmonics) 
Die zwischenharmonischen Frequenzbänder befinden sich zwischen den harmonischen 
Frequenzen. In diesen Frequenzbändern finden sich üblicherweise Störungen wie 
Signalspannungen oder andere Quellen mit von der Netzfrequenz unabhängiger 
Frequenz. 

 
g_triggersettingsinterharmonics1.bmp 

Der Trigger lässt sich auf zwischenharmonische Spannungen, Ströme, 
Nullleiterspannungen und Nullleiterströme anwenden. Zwischenharmonischen-
Grenzwerte können nur als absolute Werte definiert werden (V oder A). 
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Zeit (Time) 

 
g_triggersettingstime.bmp 

Der Zeit-Trigger ermöglicht Aufzeichnungen ausgewählter Messwerte in periodischen 
Intervallen, mit einer bestimmten Taktzeit. 

Es kann gewählt werden: 

• Startzeit (Start Time) der zeitgetriggerten Aufzeichnung (voreingestellt ist die 
nächste volle Minute der aktuellen PC-Zeit) 

• Wiederholungszeit (Repetition Time) in Sekunden 

Hinweis 
Wenn keine Wiederholungszeit angegeben ist, generiert der Zeittrigger nur 
einen Eintrag in der Ereignisliste. Die gewählten Messdaten werden mit 
den erforderlichen Taktzeiten in der aktuellen Datendatei im Fluke 1760 
gespeichert. 
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ALARM Einstellungen (ALARM Configuration) 
Digitale Alarmausgänge können über Triggerereignisse gesetzt und durch Timeout- 
und/oder digitale Eingänge zurückgesetzt werden (bei Topas 1000 wird das Alarm-Setup 
immer noch über das Menü „Service“ ausgewählt – es ist dort als Geräteeinstellung 
enthalten). Mit beiden wird das Fenster für allgemeine „ALARM Einstellungen“ 
(ALARM Configuration) geöffnet: 

 
g_alarmconfig.bmp 

Aktivieren Sie das Kästchen Inv. (Invert), um die Logik des Alarm-Ausgangskanals zu 
invertieren.  

Normalerweise werden die Ausgänge durch digitale Eingänge zurückgesetzt 
(Ausgangskanäle 1 und 2 durch Eingangskanal 1, Ausgangskanäle 3 und 4 durch 
Eingangskanal 2). Um die Funktion „Auto Reset“ nach einem Timeout zu aktivieren, 
geben Sie einen Wert größer 0 ein.   

Wenn alle Ausgangskanäle nur durch einen Timeout zurückgesetzt werden sollen, 
aktivieren Sie LPT-Reset sperren (Disable LPT-Reset). Wenn LPT-Reset sperren 
(Disable LPT-Reset) aktiviert ist und kein Timeout für einen Ausgangskanal angegeben 
ist, wird der Ausgangskanal nur durch eine Wiederinbetriebnahme des Rekorders 
ausgeschaltet. 



 Einrichten von Messungen 
 ALARM Einstellungen (ALARM Configuration) 5 

  5-25 

 ermöglicht die detaillierte Ereignisauswahl für jeden Ausgang: 

 
g_alarmout.bmp 

Klicken und ziehen Sie mit der Maus, um einen Bereich mit mehreren Zeilen/Spalten 
auszuwählen. Mit Löschen (Delete) wird der Inhalt der gesamten Matrix gelöscht. 

Gesperrte und aktivierte Zellen werden mit dem ausgewählten Verbindungsschema 
geändert (U/I, U/U, Aron usw.) 

Ausführliche Informationen zu Verbindungen und zur Steckerbelegung finden Sie unter 
„Funktionsbeschreibung“ in Kapitel 1 des Benutzerhandbuchs. 
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Auto-Trigger 
Die Auto-Trigger-Funktion kommt in Situationen zum Einsatz, in denen sich exakte 
Triggerlevel nicht einfach bestimmen lassen. Die Trigger-Engine passt sich automatisch 
an das Messsignal an.  

Öffnen Sie das Haupteinstellungsfenster, und aktivieren Sie die Option Auto. 

 
g_at1.bmp 

Wenn Auto aktiviert ist, können nur Aufzeichnungsparameter für Rundsteuer (Ripple 
Control) und Freies Intervall (Free Interval) in den Aufzeichnungsmodi (Recording 
Modes) geändert werden. Für die anderen Messfunktionen werden Parameterwerte zur 
Information angezeigt:  

 
g_recordingmodesat.bmp 
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Wenn Auto-Trigger ausgewählt ist, werden alle Einstellungen der Aufzeichnungsmodi 
(Recording Modes) mit den unten angegebenen festgelegten Werten vorkonfiguriert. 

Tabelle 5-1. Vorkonfigurierte Aufzeichnungsmodi 

Virtuelles Gerät Aggregation Vortriggerzeit Aufzeichnungsdauer 
Wartezeit zwischen 

Aufzeichnungen 

Effektivwerte 
(RMS) 

10/20 ms1 

gleitend 
0,5 s 5 s 10 s 

Oberschwingungen 
(Harmonics) 

200 ms 2 s 15 s 10 s 

Oszilloskop 
(Oscilloscope) 

Beispiel 0,1 s 0,2 s 3 s 

Transienten 
(Transients) 

500 kHz 11,08 ms 32,768 ms 5 s 

1Die Effektivwertaufzeichnung verwendet Halbperioden- oder Vollperiodenwerte, die einmal 
pro Halbperiode aktualisiert werden, entsprechend der Konfiguration im Dialog „Einstellungen“ 
(Settings) für Nenn- und Grenzwerte (Nominal / Limit values). 

 

In den Triggereinstellungen (Trigger Settings) können nur Rundsteuertrigger (Ripple 
Control Trigger) und Zeittrigger (Time Trigger) bearbeitet werden: 

 
g_triggersettingsat.bmp 
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Im Modus Auto sind folgende Trigger aktiviert: 

Tabelle 5-2. Im Modus „Auto“ aktivierte Trigger 

Virtuelles Gerät Triggertyp Kanäle Anfangsschwelle 
Getriggerte 

Aufzeichnung 

Effektivwerte 
(RMS) 

Unteres 
Spannungslimit 

UL 1,2,3, 
UN 

50 % des EN50160 95%-
Limits1 

Effektivwerte 
(RMS) 

Effektivwerte 
(RMS) 

Oberes 
Spannungslimit 

UL 1,2,3, 
UN 

50 % des EN50160 95%-
Limits1 

Effektivwerte 
(RMS) 

Effektivwerte 
(RMS) 

Spannungsänderung UL 1,2,3, 
UN 

50 % des EN50160 95%-
Limits1 

Effektivwerte 
(RMS) 

Effektivwerte 
(RMS) 

Unteres 
Frequenzlimit 

UL 1 50 % des EN50160 95%-
Limits1 

Effektivwerte 
(RMS) 

Effektivwerte 
(RMS) 

Oberes Frequenzlimit UL 1 50 % des EN50160 95%-
Limits1 

Effektivwerte 
(RMS) 

Oszilloskop 
(Oscilloscope) 

Spitzenwert UL 1,2,3, 
UN 

± oberes Limit der 
Effektivwertspannung x 2  

Oszilloskop 
(Oscilloscope) 

Oszilloskop 
(Oscilloscope) 

Wellenform UL 1,2,3, 
UN 

± Effektivwertspannungs-
Änderungslimit x 2  

Oszilloskop 
(Oscilloscope) 

Transienten 
(Transients) 

Spitzenwert UL 1,2,3, 
UN 

Unom x 0,5 x 2  Transienten 
(Transient) 

Oberschwingungen 
(Harmonics) 

THD (%) UL 1,2,3 50 % des EN50160 95%-
Limits1 

Oberschwingungen
(Harmonics) 

1) Die anfänglichen Triggerschwellen sind aus dem Fenster „EN50160“ in den Einstellungen „Nenn- und 
Grenzwerte“ (Nominal and Limit Values) abgeleitet (siehe untenstehendes Beispiel). 
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g_nlv.bmp 

 

Beispiel:  

Im obigen Fenster ist für Langsame Spannungsänderung (Slow Voltage Variations) der 
positive Wert für „95 % Limit“ (95 % limit) auf  
110 % festgelegt. Dies bedeutet Unom + 10 %. Die abgeleitete anfängliche 
Triggereinstellung für das obere Limit der Effektivwertspannung lautet Unom + 5 % (50  
% der EN50160-Einstellung).   

Das untere Auto-Trigger-Limit, das Spannungsänderungslimit und das obere und untere 
Frequenzlimit werden in der gleichen Weise vom 95 % negativen Limit Langsame 
Spannungsänderung (Slow Voltage Variations), dem 95 % Limit Schnelle 
Spannungsänderungen (Fast Voltage Variations), dem 95 % negativen Limit 
Netzfrequenz (Mains Frequency) und dem 95 % negativen Limit Netzfrequenz (Mains 
Frequency) abgeleitet. 

Die Limits für Oszilloskopspitzen und Oszilloskopwellenform sind ihrerseits an das 
obere Limit der Effektivwertspannung und die Effektivwertspannungs-Änderungslimits 
gekoppelt, in dem die Effektivwertlimits mit 2  multipliziert werden. 

Ebenso ist die anfängliche Oberschwingungs-THD-Schwelle auf 50 % der EN50160-
THD-Limiteinstellung festgelegt (im Beispiel unten auf 4 %). 
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g_nlv1.bmp 

Arbeiten mit Vorlagen 
Die Software wird mit einer Reihe von Vorlagen in Form von VDF-Dateien geliefert, die 
für bestimmte Anwendungen vorkonfiguriert sind. Diese Dateien finden Sie im Ordner 
Konfigurationsvorlagen (Configuration Templates) auf der PQ Analyze-CD-ROM. 
Wenn Sie diese Vorlagen häufiger verwenden möchten, kopieren Sie sie in das 
Unterverzeichnis PQ Analyze Ihres Verzeichnisses <Persönlich> (Personal) (siehe 
„Installationspfade“ in Kapitel 2): <Persönlich>|PQAnalyze|vdf| 
(<Personal>|PQAnalyze|vdf|) 

Die allgemeinen Vorlagen (*.vdf) können Ihren individuellen Anforderungen angepasst 
und als eigene Vorlagen gespeichert werden. Öffnen Sie die Vorlage über Menü Datei > 
Öffnen (File > Open). Ändern Sie die Einstellungen. Klicken Sie auf die Schaltfläche 
Speichern (Save), und speichern Sie die Vorlage unter einer anderen Bezeichnung. 

Vorlage Flicker.vdf 
Diese Triggerkonfiguration dient zur Aufzeichnung von Flicker. Sie reagiert bei 
Überschreitung von Absolutwerten und bei Spannungsschwankungen zwischen zwei 
Intervallen. Es kann notwendig sein, den Pegel je nach Messbedingungen auf einen 
niedrigeren Wert zu reduzieren.   
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Vorlage Harmon.vdf 
Diese Vorlage enthält die Grenzwerte gemäß EN 50160. Eine Aufzeichnung wird bei 
Überschreitung eines Spannungsgrenzwerts gestartet. Das System überwacht auf diese 
Weise die 25 Oberschwingungen der Spannung und zeichnet 3-Sek.-Werte auf. Diese 
Triggereinstellungen erfassen so die Überschreitung der Grenzwerte von 
Spannungsoberschwingungen.  

Vorlage PC.vdf 
Diese Vorlage wurde zum Aufspüren von Problemen mit dem PC, Spannungseinbrüchen 
und/oder Stromschwankungen entworfen. Sie reagiert auf Unterspannungen in den 
Phasen, Spannungsänderungen am Nullleiter, Wellenformänderungen in den 
Phasenspannungen und am Nullleiter sowie auf Spannungstransienten.   

Vorlage Rundst.vdf 
Diese Vorlage stellt Beispieleinstellungen für eine Rundsteueranlage dar. Die 
Rundsteuersignalfrequenz (Mittenfrequenz) und das Triggerlevel müssen an die 
tatsächlichen Anforderungen angepasst werden.  

Vorlage Trans.vdf 
Transienten über 50 V lösen die Aufzeichnung schneller Abtastwerte, Oszilloskop- und 
Effektivwerte aus. 

Diese Einstellungen sorgen für die Aufzeichnung einmalig auftretender, schneller 
Ereignisse im Netz, die durch schnelle Spannungsänderungen (Über- und 
Unterspannung) ausgelöst wird. Es werden die Transienten- und Effektivwertdaten 
aufgezeichnet. Das System spürt Schaltvorgänge auf. Spitzenwerte über 358 V lösen die 
Aufzeichnung von Oszilloskop- und Effektivwerten aus. 

Vorlage Overview.vdf 
Effektivwerte über 253 V, Abtastwerte über 358 V oder Transienten über 50 V lösen die 
Aufzeichnung von Oszilloskop- und Effektivwerten aus. 

Diese Einstellungen sorgen für die Aufzeichnung einmalig auftretender, schneller 
Ereignisse im Netz, die durch schnelle Spannungsänderungen (Überspannung) ausgelöst 
wird. Es werden die Transienten und Effektivwerte aufgezeichnet. Das System spürt 
Schaltvorgänge auf. Spitzenwerte über 358 V lösen die Aufzeichnung von Oszilloskop- 
und Effektivwerten aus. 
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Kapitel 6 
Analyse von Messdaten 

Download von Messdaten auf den PC 
Stellen Sie eine Verbindung zu Ihrem Rekorder her (siehe auch Kapitel 3: 
„Kommunikation mit dem Rekorder”)  

1. Wählen Sie im Menü Übertragen > Messdaten holen (Transfer > Download 
Measurement Data), oder klicken Sie auf das Symbol Datentransfer (Data Transfer). 
 

 
g_6_1.bmp 

2. Wählen Sie einen neuen Namen für diese Messkampagne, oder übernehmen Sie den 
während der Initialisierung zugewiesenen Namen. In den meisten Fällen übernehmen Sie 
die Voreinstellung, da es so möglich ist, Daten an die bereits vorhandene Datendatei 
anzuhängen. 

Hinweis 

Sie können jederzeit während einer laufenden Messung Daten auf Ihren PC 
übertragen. Die Messkampagne wird dadurch nicht unterbrochen oder auf 
sonstige Weise beeinflusst.  

Im Fenster Datentransfer (Data Transfer) können Sie die Daten auswählen, die Sie auf 
Ihren PC übertragen möchten. 
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g_6_2.bmp 

3. Ziehen Sie die blauen Cursormarken an die gewünschten Positionen, um Start- und 
Endzeit der zu kopierenden Daten festzulegen.  

4. Wählen Sie die „virtuellen Geräte“, die in den Download inkludiert werden sollen 
(Schaltflächen auf der linken Seite des Fensters). 

Die roten Balken weisen auf Daten im Gerät hin, die für den Download verfügbar sind. 
Die blauen Balken kennzeichnen Daten, die bereits auf den PC kopiert wurden. 

Hinweis 

Sie können Daten der gleichen Messkampagne inkrementell kopieren (an 
bestehende Daten anhängen). Solange Sie nicht die Bezeichnung der 
gespeicherten Messung verändern, werden alle Daten zusammengefügt. 

Mit den vorhandenen Schaltflächen gestaltet sich die Datenauswahl sehr einfach.  

Schaltflächen zur Veränderung des Zeitbereichs:  

 
g_6_3.bmp 

Schaltfläche zur Auswahl virtueller Geräte: 

 
g_6_4.bmp 

5. Klicken Sie auf Kopieren (Copy), um die ausgewählten Daten auf den PC zu kopieren. 
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6. Klicken Sie nach Abschluss der Übertragung auf die Schaltfläche Auswahlfenster in 
Vordergrund/Auswertung starten (Analysis-Panel to front), um das 
Hauptauswertefenster aufzurufen (siehe auch Kapitel 4: „PQ Analyze Übersicht“). 

 
g_6_5.bmp 

Analyse von Trenddaten 
Es gibt drei virtuelle Geräte, die kontinuierlich Trenddaten messen: 

1. 10 Min 

2. Freies Intervall (Free Interval) 

3. Tag (Day) 

Während 10 Min und Tag (Day) feste Aggregationsintervalle verwenden, kann die 
Aggregation für Freies Intervall (Free Interval) vom Anwender zwischen 10 Sekunden 
und 1 Tag eingestellt werden. 

10 Min ist die Basisaggregation, die von verschiedenen Netzqualitätsnormen wie 
IEC 61000-4-30 Ed.2 oder EN 50160 vorausgesetzt wird. 

Tag (Day) kann für langfristige Lastprofile und die Überwachungen von 
Spannungsverläufen verwendet werden.  

Freies Intervall (Free Interval) ist ein allgemeines Gerät, das sich an die Anforderungen 
der jeweiligen Anwendung anpassen lässt.  

Gehen Sie wie folgt vor, um Ihre Messdaten zu analysieren.  

1. Wählen Sie das virtuelle Gerät. 

2. Wählen Sie die Startzeit.  

3. Wählen Sie die Endzeit.  
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g_6_6.bmp 

Alternativ können Sie in der Dropdown-Liste Differenz (Difference) ein vordefiniertes 
Zeitintervall wählen und es dann mit den Links/Rechts-Pfeiltasten verschieben. Dies hat 
den Vorteil, dass Start- und Stoppzeit auf die gewählte Intervalllänge abgestimmt sind.  

 
g_6_7.bmp 

Die Symbolliste auf der linken Seite des Hauptfensters repräsentiert die verfügbaren 
Parametergruppen. Dabei handelt es sich um Sätze zusammenhängender Messparameter. 
Bewegen Sie die Maus über die einzelnen Symbole, um nähere Informationen zu 
erhalten. 
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g_6_8.bmp 

Wählen Sie die Parametergruppe und anschließend den Messparameter 
(Parametersymbolleiste am oberen Rand). Durch Tool-Tips erhalten Sie zusätzliche 
Informationen zu jedem Parameter. 

 
g_6_9.bmp 

Hinweis 

Weitere Parameter sind im Menü „Messung“ (Measurement) verfügbar. 

Wählen Sie die Mittelwert-, Minimum-oder Maximum-Ausführung (Mean, Minimum, 
Maximum), und klicken Sie auf eine der verfügbaren Analysefunktionen. 

 
g_6_10.bmp 

Wenn Sie Oberschwingungen oder Zwischenharmonische auswerten, können Sie wählen, 
ob die Daten in Absolutwerten oder relativ zur Grundschwingung angezeigt werden 
sollen. Für Ströme gibt es eine zusätzliche Option Relativ zu IL (Spitzenlaststrom) 
(Relative to peak load current). 

 
g_6_11.bmp 
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Hinweis 

THD-Messungen mit der Option Relativ zu IL (Relative to IL) werden auch 
als TDD (total demand distortion) oder Gesamtverzerrungsfaktor 
bezeichnet. 

Wählen Sie eins der verfügbaren Analysewerkzeuge Pegel-Zeit-Diagramm, 
Wahrscheinlichkeit, Tagesextremwerte oder Balkendiagramm (Tagesextremwerte) 
(Timeplot, Probability, Day extreme value, Bargraph (Day extreme value)). 

 
g_6_12.bmp 

Die Parametergruppen Oberschwingungen und Zwischenharmonische (Harmonics, 
Interharmonics) unterstützen das Werkzeug Spektrum (Spectrum) zusätzlich. 

 
g_6_13.bmp 

Pegel-Zeit-Diagramm (Timeplot) 

 
g_6_14.bmp 
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Das Pegel-Zeit-Diagramm (Timeplot) enthält die folgenden Informationen: 

• Start- und Endzeit der angezeigten Daten 

 
6_15.bmp 

Hinweis 

Mit der Funktion Auto Refresh im Hauptauswertefenster können Sie die 
Zeitbereichsauswahl mit den Cursor Links/Rechts-Schaltflächen oder den 
entsprechenden Tasten auf der Tastatur nach links und rechts verschieben. 

• Detaillierte Informationen im Zusammenhang mit den zwei Cursormarken 
(blauer Cursor und roter Cursor). 

o Ausgewählter Parameter 

o Datum und Zeit des gewählten Datenpunkts  

o Größenordnung des gewählten Datenpunkts  

 
g_6_16.bmp 

o X- und Y-Achsendifferenzen zwischen den beiden Cursorpositionen 

 
6_17.bmp 

• Auswahl der vertikalen Skala auf der linken und rechten Seite des Diagramms. Die 3 
Farben geben die für die 3 Phasen des Stromnetzes verwendeten Farben an (A, B, C / L1, 
L2, L3). Verwenden Sie das Dropdown-Listenfeld, um die Zuordnung der Skalen zu 
ändern.  

 
6_18.bmp 
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• „Geflaggte“ Daten werden in Form eines vertikalen Balkens hinter den Diagrammdaten 
angezeigt. Diese Informationen beziehen sich auf die Flaggingkonzeptanforderung der 
Norm IEC 61000-4-30 Ed. 2. Die hervorgehobenen Abschnitte enthalten mindestens 
einen „geflaggten“ Parameter (Auftritt von Unterspannungen, Überspannungen oder 
Unterbrechungen in diesem Intervall).  

 
6_19.bmp 

Mit dem Kontrollkästchen Add können Sie weitere Parameter zum Diagramm 
hinzufügen. 

 
g_6_20.bmp 

In dem gezeigten Fall möchten Sie näher untersuchen, was die Ursache für das Flagging 
war. Dies könnte ein Spannungseinbruch sein. Wählen Sie die Minimum-Werte aus, und 
fügen Sie die Daten zum Diagramm hinzu, indem Sie auf das Pegel-Zeit-Diagramm-
Symbol (Timeplot) klicken. 

 
g_6_21.bmp 
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Der Spannungseinbruch ist nun deutlich zu sehen. 

 
g_6_22.bmp 

Um mehr Details anzuzeigen, verwenden Sie das Werkzeug Zoom in, und wählen Sie 
den gewünschten Zoombereich. 

 
G_6_23.bmp 
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G_6_24.bmp 

 

Wenn Sie den Eindruck haben, dass die farbige Flagging-Markierung die 
Diagrammfarben stört, schalten Sie sie ab. 

 
G_6_25.bmp 

Um den Cursor in den Normalzustand zurückzuschalten, klicken Sie links außerhalb des 
Diagrammfensters. 
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G_6_26.bmp 

Die vergrößerte Datenansicht stellt sich wie folgt dar. 

 
G_6_27.bmp 

Sie möchten wahrscheinlich wissen, was zu diesem Zeitpunkt mit dem Strom passiert ist. 
Fügen Sie einfach die Maximalstromwerte zum Diagramm hinzu. 

 
G_6_28.bmp 

Das Diagramm wird an dieser Stelle ein bisschen unübersichtlich. 
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G_6_29.bmp 

Rufen Sie mit der Schaltfläche Plots EIN/AUS (Show/Hide Plots) die Liste der 
angezeigten Parameter auf, und wählen Sie die Parameter, die Sie anzeigen möchten. 

 
G_6_30.bmp 

Das Fenster Plots EIN/AUS (Show/Hide Plots) zeigt auch, welche Parameter „geflaggt“ 
sind, und listet alle Parameternamen und Farben auf. 

 
G_6_31.bmp 

Sehen Sie sich mit dem Kontextmenü (rechte Maustaste) die erweiterten Einstellungen 
und Funktionen des Pegel-Zeit-Diagramms (Timeplot) an. 
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G_6_32.bmp 

Wahrscheinlichkeit (Probability) 

 
G_6_33.bmp 

Die Wahrscheinlichkeitsverteilung (auch als Histogramm bezeichnet) gibt die 
Wahrscheinlichkeit an, dass eine Parametergröße einen bestimmen Wert überschreitet. 

Im oben abgebildeten Screenshot liest sich dies für die beiden Cursorpositionen wie folgt:  

„Die Wahrscheinlichkeit, dass die Phasenspannung L1 231,61 V überschreitet, liegt bei 
85,417 %.“ 
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„Die Wahrscheinlichkeit, dass die Phasenspannung L1 234,28 V überschreitet, liegt bei 
37,103 %.“ 

Tagesextremwerte (Day extreme value) 

 
G_6_34.bmp 

Das Werkzeug Tagesextremwerte (Day extreme value) dient der Analyse täglicher 
Lastprofile. 

Sie werden aufgefordert, die in die Analyse aufzunehmenden Wochentage auszuwählen. 
Bei einem Industriestandort könnte es sinnvoll sein, die Wochentage Montag bis Freitag 
zu prüfen, um das Profil eines typischen Arbeitstags (oder was einem normalen 
Betriebstag entsprechen würde) zu bewerten.  

 
G_6_35.bmp 

Die Messdaten aller in die Beobachtungszeit gehörenden Tage werden berücksichtigt und 
drei verschiedene Profile für jede Phase berechnet. 

• Durchschnittliches Tagesprofil (arithmethischer Mittelwert) 
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• Maximales Tagesprofil (Höchstwerte aller Punkte in der Zeit) 

• Minimales Tagesprofil (Tiefstwerte aller Punkte in der Zeit) 

Balkendiagramm (Tagesextremwerte) (Bargraph (Day extreme value)) 

 
G_6_36.bmp 

Das Werkzeug Balkendiagramm für Tagesextremwert (Bargraph (Day extreme value)) 
entspricht in etwa einem Wochenprofil. Für jeden Tag der Woche werden Mittel-, 
Höchst- und Minimalwerte angezeigt.   

Die Mittelwerte sind durchschnittliche Effektivwerte der jeweiligen Tage.  
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Spektrum (Spectrum) 

 
G_6_37.bmp 

Das Werkzeug Spektrum (Spectrum) zeigt das klassische Oberschwingungen-
Balkendiagramm an. Positionieren Sie die Cursormarken, um nähere Informationen zu 
bestimmten Linien zu erhalten.   

Statistische Bewertung des Stromnetzes  
Wählen Sie im Hauptauswertefenster das virtuelle Gerät EN50160 . Diese Messfunktion 
führt die statistische Bewertung gemäß Europäischer Norm EN50160 durch. Bei 
EN50160 erfolgt die Aufzeichnung in Intervallen von 10 Minuten. Alle erforderlichen 
Parameter werden gemessen und mit vordefinierten Grenzwerten verglichen.  

Die Norm legt eine Beobachtungszeit von einer Woche für die statistische Auswertung 
der meisten Parameter fest. Es empfiehlt sich, mithilfe der Dropdown-Liste Differenz 
(Difference) präzise eine Woche auszuwählen. Dadurch werden Start- und Stopzeiten 
automatisch auf die Datumsgrenzen abgestimmt.  
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G_6_38.bmp 

Klicken Sie auf die Schaltfläche EN50160.  

 
G_6_39.bmp 

Die Netzqualitätsparameter werden in einem leicht verständlichen und aussagekräftigen 
Übersichtdiagramm dargestellt. 
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G_6_40.bmp 

Rote Balken geben die Ergebnisse während 95 % der Messzeit wieder und blaue 
übereinandergelegte Balken die Ergebnisse während 100 % der Messzeit. Der 95 %-Wert 
entspricht der absoluten standardisierten Toleranzabweichung, die während 95 % der Zeit 
nicht überschritten werden darf. Der 100 %-Wert entspricht der absoluten 
standardisierten Toleranzabweichung, die während 100 % der Zeit nicht überschritten 
werden darf. Die Abstände zur standardisierten Begrenzungslinie geben den Reservewert 
an. Um statistische Details anzuzeigen, klicken Sie auf die entsprechenden Schaltflächen 
im Diagrammfenster.  

Mit diesem visuellen Werkzeug können Sie die Qualität Ihres Stromnetzes sehr schnell 
überprüfen und Problembereiche lokalisieren.  

Klicken Sie auf die Schaltfläche EN50160 Textprotokoll (EN50160 Text Protocol), um 
in kürzester Zeit einen Bericht mit allen wichtigen Daten zu erstellen. 

Analyse von Ereignissen 
Der Power Quality Recorder unterstützt mehr als 120 unterschiedliche Ereignisarten. Die 
verschiedenen Ereignistypen sind in Gruppen organisiert, wie unten dargestellt.  

Um sich einen umfassenden Überblick zu verschaffen, ist die beste Methode, die 
Ereignisanalyse zu beginnen, das CBEMA-Diagramm. CBEMA- und ANSI-Kurven sind 
unterschiedliche Grenzwertkurven, die Bedingungen definieren, unter denen 
elektronische Instrumente (insbesondere Computer) einwandfrei funktionieren sollten.  

Wählen Sie im Hauptauswertefenster die Option Ereignisse (Events), und klicken Sie auf 
die Schaltfläche Cursor auf Maximum (Moves cursor to maximum), um alle 
verfügbaren Ereignisse in der Auswertung aufzunehmen. 
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G_6_41.bmp 

Klicken Sie auf die Schaltfläche CBEMA – Auswertung (CBEMA – Curve), um die 
grafische Ereignisübersicht zu erzeugen. 

 
G_6_42.bmp 

 
G_6_43.bmp 

Das Diagramm enthält Spannungsereignisse in % (bezogen auf die Nennspannung) über 
die Ereignisdauer (logarithmischer Zeitmaßstab). Die Ereignisse sind durch farbige 
Punkte dargestellt, wobei die Farbe Typ und Phase angibt. Der Bereich zwischen den 
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Kurven entspricht dem zulässigen Bereich für die ungestörte Gerätefunktion. Ereignisse 
im Bereich über der oberen Kurve können elektronische Geräte potenziell beschädigen. 
Ereignisse unterhalb der unteren Kurve wirken sich auf die korrekte Funktion der mit 
dem Stromnetz verbundenen Geräte aus, rufen aber keine Schäden hervor. 

Klicken Sie auf ein Ereignis, um die Cursormarkierung zu verschieben und zusätzliche 
Informationen auf der linken Seite anzuzeigen. Doppelklicken Sie auf ein Ereignis, um 
alle dazugehörigen Aufzeichnungen zu öffnen (Pegel-Zeit-Diagramme). Die vertikale 
rote Linie gibt die Triggerzeit an. 

 
G_6_44.bmp 

Hinweis 

In der CBEMA-Kurve finden nicht alle Ereignistypen Berücksichtigung, 
sondern nur solche, die als Prozentwert der Nennspannung dargestellt 
werden können. Um alle Ereignisarten zu überprüfen, verwenden Sie bitte 
das Ereignisdatenbank-Werkzeug. Wenn sich keine CBEMA-Ereignisse im 
ausgewählten Zeitbereich befinden, wird das Diagramm nicht angezeigt.  

Klicken Sie zwecks Prüfung aller Ereignisarten auf die Schaltfläche Ereignisse (Event 
Database). 

 
G_6_45.bmp 

Das Übersichtfenster Ereignisse – Auswertung (Events – Analysis) zeigt die 
verschiedenen Ereignisgruppen und alle dazugehörigen Ereignistypen in einer 
hierarchischen Baumansicht an. Der Zählwert auf der rechten Seite gibt die 
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Gesamtanzahl der Ereignisse für jeden Listeneintrag an. Das Markierungszeichen neben 
dem Titel weist darauf hin, dass die jeweilige Gruppe markierte Ereignisse enthält. 

 
G_6_46.bmp 

Hinweis 

EN50160 bezieht sich auf Einbrüche, Spitzenwerte und Unterbrechungen. 

Mit der Dropdown-Liste können Sie die Ereignisse filtern. Gemäß IEC 61000-4-30 Ed. 2 
erfüllt das Flagging den Zweck, das mehrfache Zählen eines Ereignisses zu verhindern. 
Wählen Sie die passende Klassifizierung.  

 
G_6_47.bmp 

Hinweis 

EN50160-Ereignisse sind definitionsgemäß ungeflaggt, da sie die Quelle 
für Flagging darstellen. 

Klicken Sie auf die Schaltfläche Aktive Ereignisse (Active Events), um alle registrierten 
Ereignisse auszuwählen. 

 
G_6_48.bmp 

Mit dem Werkzeug Pegel / Dauer (Level / Period) können Sie alle Ereignisse in einem 
X-Y-Diagramm anzeigen lassen (Größenordnung über Ereignisdauer). 
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G_6_49.bmp 

 
G_6_50.bmp 

Doppelklicken Sie auf ein beliebiges Ereignis, um die dazugehörigen Aufzeichnungen 
anzuzeigen. 

 
G_6_51.bmp 

Mit der Schaltfläche Detail können Sie eine Liste aller Ereignisse mit Detailinformation 
erzeugen (Typ, Quelle, Startzeit, Dauer, Extremwert, Markierungsdaten). 
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G_6_52.bmp 

Ereignisse – Tabelle (Events – Table) listet alle ausgewählten Ereignisse auf. Klicken 
Sie auf die Feldnamenüberschriften, um die Sortierung der Tabelle zu ändern. Die blaue 
Farbe weist bei Ereigniseinträgen darauf hin, dass aufgezeichnete Daten verfügbar sind. 
Doppelklicken Sie auf das Ereignis, um die dazugehörigen Pegel-Zeit-Diagramme 
aufzurufen. Die letzte Spalte („F“) gibt den Markierungsstatus an. Bei markierten 
Ereignissen ist sie  mit einem „!“ gekennzeichnet. 

 
G_6_53.bmp 

Hinweis 

Wählen Sie die Optionsfolgen Bearbeiten > Alles markieren (Edit > Mark 
All) und Bearbeiten > Kopieren (Edit > Copy), um alle Ereignisdaten in 
die Zwischenablage zu kopieren. 
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Analyse getriggerter Aufnahmen 
Der Rekorder bietet verschiedene Möglichkeiten zur Triggereinstellung für die 
Aufzeichnung von Messdaten (siehe auch Kapitel 5: „Einrichten von Messungen – 
Triggereinstellungen“). Wird einer dieser Triggerschwellwerte überschritten, beginnen 
die angegebenen virtuellen Geräte die Aufzeichnung wie vom Anwender konfiguriert 
(siehe auch Kapitel 5: „Einrichten von Messungen – Aufnahmemodi“).  

Folgende virtuelle Geräte sind verfügbar: 

• Oberschwingungen (Harmonics) (200 ms oder 3 s aggregierte 
Oberschwingungsdaten) 

• Effektivwerte (RMS) (schnelle RMS-Daten 10 ms/20 ms/200 ms/3 s) 

• Oszilloskop (Oscilloscope) (ADC-Abtastdaten) 

• Rundsteuerung (Ripple Control) (Überwachung spezieller Frequenzen wie 
Signalspannungen) 

• Transienten (Transient) (schnelle Transientenaufzeichnung 100 kHz bis 10 MHz) 

Hinweis 

Nur die Kanäle Ch1 bis Ch4 können für Transientenaufzeichnungen genutzt 
werden. 

Gehen Sie wie folgt vor, um Ihre Messdaten zu analysieren.  

1. Wählen Sie das virtuelle Gerät. 

2. Wählen Sie die Startzeit.  

3. Wählen Sie die Endzeit.  

 
G_6_54.bmp 

Für die Optionen Oszilloskop (Oscilloscope) und Transienten (Transient) sind Kanäle 
auszuwählen. 
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G_6_55.bmp 

Wählen Sie die Parametergruppe (falls verfügbar) und den anzuzeigenden Parameter aus. 

 
G_6_56.bmp      

Wählen Sie eines der verfügbaren Analysewerkzeuge. 

Für die virtuellen Geräte Oberschwingungen (Harmonics), Effektivwerte (RMS) und 
Rundsteuer (Ripple Control) sind dies Pegel-Zeit-Diagramm, Wahrscheinlichkeit  
und Spektrum (Timeplot, Probability, Spectrum). 

 
G_6_57.bmp 

Für Oszilloskop (Oscilloscope) und Transienten (Transient) sind dies Pegel-Zeit-
Diagramm (Timeplot), Spektrum (Spectrum), Wirkleistungsspekturm (Active Power 
Spectrum), Blindleistungsspektrum (Reactive Power Spectrum), Zeigerdiagramm 
Grundschwingung (Phasor view fundamental) und Mittel- und Effektivwerte (RMS 
Values). 
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G_6_58.bmp 

Die Analysewerkzeuge Pegel-Zeit-Diagramm (Timeplot), Wahrscheinlichkeit 
(Probability) und Spektrum (Spectrum) werden in diesem Kapitel im Abschnitt „Analyse 
von Trenddaten“ erläutert. 

Bei der Verwendung mit getriggerten Aufnahmen gibt es jedoch ein paar zusätzliche 
Funktionen. 

Pegel-Zeit-Diagramm (Timeplot) 
In Verbindung mit den Messungen Oberschwingungen (Harmonics), Effektivwerte 
(RMS) und Rundsteuer (Ripple Control) können Sie die Option 
Ereignisweiterschaltung (Event Stepping) nutzen. 

Klicken Sie auf die Schaltfläche Pegel-Zeit-Diagramm (Timeplot). Alle 
Aufzeichnungen im gewählten Zeitbereich werden in einem gemeinsamen Fenster 
angezeigt. Dieses Diagramm ist eine Übersicht, die nicht sonderlich viele Details zeigt. 

 
G_6_59.bmp 
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Die effektivste Methode zur Detailanalyse aller Netzqualitätsereignisse stellt die Option 
Ereignisweiterschaltung bzw. Auto Refresh (Event Stepping (Auto Refresh)) dar. 

 
G_6_60.bmp 

Mit aktivierter Option Auto Refresh können Sie die einzelnen Aufzeichnungen innerhalb 
des gewählten Zeitbereichs durchlaufen, indem Sie auf die Cursor Links/Rechts-
Schaltflächen klicken oder die entsprechenden Tasten auf der Tastatur verwenden.  

 
G_6_61.bmp 
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In Verbindung mit der Messung Oszilloskop (Oscilloscope) können Sie die Anzahl der 
im Pegel-Zeit-Diagramm angezeigten Abtastwerte einstellen. Doppelklicken Sie am 
gewünschten Startpunkt auf das Diagramm. Wählen Sie im Dialogfenster die Anzahl der 
Abtastwerte.  

Hinweis 
Wenn diese Funktion dazu verwendet wird, das Frequenzspektrum (siehe 
nächsten Abschnitt) anzuzeigen, wählen Sie nicht weniger als 1.024 
Abtastwerte aus. Anderenfalls ergeben die Spektrumberechnungen 
unzuverlässige Ergebnisse. 

 
G_6_62.bmp 

Klicken Sie auf OK und nochmals auf die Schaltfläche Pegel-Zeit-Diagramm 
(Timeplot). Im Diagramm wird nun ein reduzierter Datenanteil angezeigt. 
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G_6_63.bmp 

Hinweis 

Die Änderung der Anzahl angezeigter Abtastwerte ist dauerhaft. Um zur 
ursprünglichen Einstellung zurückzukehren, verschieben Sie die 
Cursormarken für Start- oder Endzeit im Hauptauswertefenster. 
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Spektrum 
In Verbindung mit den Messungen Oszilloskop (Oscilloscope) und Transienten 
(Transient) zeigt das Werkzeug Spektrum (Spectrum) das kontinuierliche 
Frequenzspektrum an. Die Frequenzbereichsdaten werden aus den Abtastwerten 
berechnet. Werden die angezeigten Abtastwerte reduziert (siehe Pegel-Zeit-Diagramm 
(Timeplot)), so gilt dies auch für die FFT-Berechnung. 

 
G_6_64.bmp 

Hinweis 
Der Zeitbereich der angezeigten Daten beeinflusst das Ergebnis der FFT-
Berechnung. 
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Wirkleistungs- und Blindleistungsspektrum 
In Verbindung mit der Messung Oszilloskop  (Oscilloscope) sind zwei weitere 
Werkzeuge zur Bewertung des Leistungsspektrums verfügbar. Wählen Sie mit den 
Schaltflächen L1, L2, L3 die Phase aus, und wählen Sie entweder das 
Wirkleistungsspektrum (P) oder das Blindleistungsspektrum (Q). 

 
G_6_65.bmp 

 
G_6_66.bmp 
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Zeigerdiagramm Grundschwingung (Phasor View Fundamental) 
Das Werkzeug Zeigerdiagramm (Phasor View) bezieht sich auf die Messung 
Oszilloskop (Oscilloscope). Aus den Abtastdaten werden die Effektivwerte und 
Phasenwinkel der Grundschwingungskomponenten berechnet und im Vektordiagramm 
dargestellt. 

 
G_6_67.bmp 

Hinweis 

Beachten Sie bitte, dass die Spannungsphase 1(A/L1) definitionsgemäß 
aufwärts zeigt und positive Winkel in Uhrzeigerrichtung gezählt werden. 



 Analyse von Messdaten 
 Analyse getriggerter Aufnahmen 6 

  6-33 

Mittel- und Effektivwerte (RMS Values) 
Das Werkzeug Mittel- und Effektivwerte (RMS Values) bezieht sich auf die Messung 
Oszilloskop (Oscilloscope). Aus den Abtastdaten werden die Effektivwerte berechnet 
und in Tabellenform angezeigt.  

 
G_6_68.bmp 
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Kapitel 7 
Export von Messdaten 

Übersicht über die Exportfunktionen 
PQ Analyze bietet verschiedene Werkzeuge und Schichten für Export- und 
Berichtsfunktionen: 

• Diagrammexport aus den Auswertefenstern (Zwischenablage, MS Word, 
Drucker) 

• Tabellendatenexport aus den Auswertefenstern (Zwischenablage, Textdatei, MS 
Word, MS Excel, Drucker) 

• EN50160-Export in Textdatei, Zwischenablage, MS- Word oder auf den Drucker 

• Ereignistabellenexport in Textdatei, Zwischenablage, MS-Word, MS-Excel oder 
auf den Drucker 

• Konfigurierbare ASCII-, Excel- und Word-Berichte 

Diagrammexport aus dem Auswertefenster 
Wählen Sie virtuelles Gerät, Messparameter und Auswertungsfunktion zur Erzeugung 
Ihres Analysediagramms.  

Klicken Sie auf eine der Exportfunktionsschaltflächen zum Exportieren in die 
Zwischenablage, auf den Drucker oder in MS Word.  

 
G_7_1.bmp 
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G_Wordexport.bmp 

Tabellendatenexport aus dem Auswertefenster 
Wählen Sie virtuelles Gerät, Messparameter und Auswertungsfunktion zur Erzeugung 
Ihres Analysediagramms.  

Wählen Sie die Optionen Tabelle anzeigen (Show Table) oder Tabelle in Datei 
kopieren (Copy Table into File). 
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G_7_3.bmp 

Das Werkzeug Tabelle anzeigen (Show Table) öffnet ein Textbetrachterfenster. 

 
7_4.bmp 

Aus diesem Fenster können Sie den kompletten Text mit den Optionsfolgen Bearbeiten 
> Alles markieren (Edit > Mark All) und Bearbeiten > Kopieren (Edit > Copy) in die 
Zwischenablage kopieren. 

Das Menü Datei (File) enthält Funktionen zum Drucken, Speichern und Exportieren der 
Daten in Form von Word- oder Excel-Exporten. 



1760 
Referenzhandbuch 

7-4 

EN50160-Export 
Wählen Sie das virtuelle Gerät EN50160 , und öffnen Sie einen der beiden EN50160-
Berichte.  

 
G_7_5.bmp 

Klicken Sie auf die Schaltfläche EN50160 Textprotokoll (EN50160 Text Protocol), um 
alle Ihre statistischen Daten in einem durchdacht organisierten Textprotokoll abzurufen. 

 
g_EN50160TextExport.bmp 

Aus diesem Fenster können Sie den kompletten Text mit den Optionsfolgen Bearbeiten 
> Alles markieren (Edit > Mark All) und Bearbeiten > Kopieren (Edit > Copy) in die 
Zwischenablage kopieren.  

Das Menü Datei (File) enthält Funktionen zum Drucken, Speichern und Exportieren der 
Daten in Form von Word-Exponaten. 
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Ereignistabellenexport 
Wählen Sie das virtuelle Gerät Ereignisse (Events), und öffnen Sie das Fenster 
Ereignisse (Event Database).  

 
G_7_7.bmp 

 
G_7_1.bmp 

Klicken Sie auf Details, um die detaillierte Ereignistabelle anzuzeigen. 
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G_7_9.bmp 

Aus diesem Fenster können Sie den kompletten Text mit den Optionsfolgen Bearbeiten 
> Alles markieren (Edit > Mark All) und Bearbeiten > Kopieren (Edit > Copy) in die 
Zwischenablage kopieren. 

Das Menü Datei (File) enthält Funktionen zum Drucken, Speichern und Exportieren der 
Daten in Form von Word- oder Excel-Exporten. 
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Konfigurierbare ASCII-, Excel- und Word-Berichte 

Anwendungsdatenverzeichnis  
Die für dieses Verfahren erforderlichen Dateien sind standardmäßig unter 
<Anwendungsdaten>\PQAnalyze\Export (<AppData>\PQAnalyze\Export) gespeichert 
(siehe „Installationspfade“). 

Definition der Exportkonfiguration  
Wählen Sie Optionen > Exportkonfiguration  

 
G_exportkonfiguration.bmp 

Im Fenster „Exportkonfiguration“ werden Dateinamen für die Exportvorlage (je nach 
Einstellung der automatischen Protokollierung eine Word-Vorlage oder ein Excel-Makro) 
und die Export-Konfigurationsdatei (Konfiguration der Messgrößen) angegeben. 

 
G_Exporteditor.bmp 
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Mit der Option Auto-Report (Auto Report) wird die Excel-Zwischendatei erzeugt und 
automatisch der Prozess zur Erstellung des endgültigen Word-Berichts auf der Grundlage 
der vorhandenen Word-Vorlage aufgerufen. 

Die Aktivierung der Option EN50160 in Report einfügen (Add EN50160 to report) 
bewirkt, dass die grafische EN50160-Zusammenfassung in den endgültigen Messbericht 
eingefügt wird. 

Exporteinrichtungsdatei 
In der Datei Config\ExportSetup_sample.ini  werden die Messparameter für den Export 
festgelegt und gespeichert. Diese Datei enthält bereits viele sinnvolle Messgrößen. 
Alternativ können Sie die leere Datei Config\ExportSetup_empty.ini verwenden. Sie 
können Setup-Dateien mit dem Exporteditor ändern oder neue erstellen (siehe 
„Exporteditor“)  

Word-Vorlage/EXCEL Makro 
Es werden zwei vorbereitete Excel-Dateien mitgeliefert :  

• Mittels der Datei Export_simple.xls lassen sich Messungen in Excel exportieren. 

• Die Datei Export_to_Word.xls enthält ein Makro für die anschließende Übertragung 
der Auswertungsdiagramme in eine Word-Datei. Bei aktivierter Option Auto-Report 
(Auto Report) erfolgt die Übertragung in das ausgewählte Word-Dokument 
automatisch. 

Die Datei Template\Report.dot ist die Vorlage für einen Bericht, der die 
Messungseinstellungen und danach alle exportierten Diagramme enthält. Die 
importierten Daten werden ab dem Text #settings# in der Reihenfolge eingetragen, wie 
sie in der Excel-Datei erscheinen. 
Die Datei Template\ReportUserDefined.dot enthält einige Textmarken für die Platzierung 
von Diagrammen, Tabellen und Marken (Labels). 

Name Beschreibung 

#settings# Platzhalter für die Einstellungen 

#table1#, #table2#: Platzhalter für Tabellen (Diagrammlegenden)  

#pic1# #pic2# usw. Platzhalter für Diagramme, die als Grafik eingefügt werden 

Die Datei Template\Report_2Columns.dot ist so formatiert, dass die Diagramme in zwei 
Spalten des Berichts eingetragen werden. 

Datenarchiv  
Hier legen Sie den Pfad für Messdateien fest. Das Archiv enthält die vorläufigen und 
endgültigen Excel- und Word-Berichte. 

Die gewählten Dateinamen werden nach Schließen des Fensters gespeichert und bilden 
die Basis für den nachfolgenden Datenexport. 

Exporteditor  
1. Öffnen Sie eine Fluke 1760 Messwertdatei. 

2. Wählen Sie die Export-Konfigurationsdatei ExportSetup_sample.ini. 

3. Öffnen Sie den Exporteditor mit .  

4. Der Exporteditor zeigt eine Liste der bereits festgelegten Messgrößen.  
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5. Liste mit + öffnen (wie beim Windows Explorer). 
 Die in Klammern gesetzte Zahl vor den Messgrößen gibt die Spaltenposition der 
Messgröße in der Excel-Tabelle an. 

Hinweis  
Die Zahl gibt nicht die Spaltennummer an, sondern nur die Reihenfolge des 
Exports. Viele Größen bestehen aus mehreren Spalten (z. B. Zeit und 3 
Spalten für die 3 Phasen). 

 
Öffnet einen Dialog, in dem die Positionsnummer der Messgröße sowie die 
Anzahl der exportierten Spalten geändert werden kann.  

Wird die Positionsnummer auf den Wert einer bereits bestehenden geändert, erhöhen sich 
alle nachfolgenden Nummern um 1. Damit ist es möglich, eine Messgröße an einer 
bestimmten Position einzufügen.  

 
G_exporteditpos.bmp 

Eine Messgröße besteht aus bis zu 5 Spalten.  

Beispiel: 

Leistungsfaktor PF:  

Spalte 1: Zeit; Spalte 2: PF Phase L1; Spalte 3: PF Phase L2; Spalte 4: PF Phase L3; 
Spalte 5: PF Summe. 

Normalerweise wird eine Messgröße immer vollständig exportiert. Das bedeutet, mit 
Zeitachse und allen Wertachsen.  

Bei mehreren Messgrößen gleicher Intervalldauer ist es sinnvoll, die Zeitachse nur einmal 
zu exportieren.  

Ist die Zeitspalte einiger Messgrößen ausgeblendet, werden diese Darstellungen in einem 
Diagramm zusammengefasst. Ist die Zeitspalte eingeblendet, wird jeweils ein eigenes 
Tabellenblatt für das Diagramm angelegt.  

Auch einzelne Phasen können auf diese Weise weggeschaltet werden. 

Entfernt eine bereits konfigurierte Größe aus der Liste. 

Verwirft die durchgeführten Änderungen und schließt den Exporteditor.  

 

Speichert die Änderungen an der Konfiguration. Es wird ein Dateidialog zum 
Umbenennen der Setup-Datei angezeigt. Anschließend wird der Exporteditor 
geschlossen.  
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Hinzufügen neuer Parameter 
Der Exporteditor arbeitet ähnlich wie die Makroerstellung in MS Office®-Paketen. 

Ist der Exporteditor geöffnet, führt jede Auswertung, die mit geladenen Messdaten 
durchgeführt wird, zu einem neuen Eintrag in der Liste. 

 
G_exporteditmw.bmp 

Vorgangsweise 
1. Messung öffnen und Zeitbereich (time period) im Auswertungsfenster wählen. 

2. Messgröße wählen . 

3. Mittelungsmodus wählen.    

4. „Auswertung“ wählen.  

Es erscheint ein Diagramm und ein Eintrag für die betreffende Messgröße in der Liste. 

1. In Position nicht gewünschte Spalten (z. B. Zeit bei weiteren Größen) ausblenden. 

2. Nächste Größe auswählen. 

3. Auf  klicken. Es erscheint ein Dateidialog zur Umbennung der 
Einrichtungsdatei. 



 Export von Messdaten 
 Konfigurierbare ASCII-, Excel- und Word-Berichte 7 

  7-11 

Berichte erstellen 
Zum Erstellen von Berichten muss eine Konfigurationsdatei vorbereitet werden. Sie 
können eine Excel-Datei für die Ergebnisse des Exports oder eine Word-Vorlage für den 
endgültigen Bericht verwenden. Geeignete Beispieldateien sind im Software-Paket 
enthalten.  

Ist eine Messdatei geöffnet, können alle in der Konfigurationsdatei enthaltenen 
Messgrößen mit einem Mausklick exportiert werden. 
 
Zuvor muss lediglich der Zeitbereich gewählt werden, über den der Export erfolgen soll. 

 

 Startet den Excel-/Word-Reportgenerator 

 

Alternativ können Sie auch ein ASCII-Protokoll erstellen: 

 Startet den ASCII-Reportgenerator 

ASCII-Berichte 
Voraussetzung für die Erstellung von ASCII-Berichten ist eine vorbereitete 
Konfigurationsdatei ExportSetup_sample.ini. 

1. Öffnen Sie die Messdatei. 

2. Wählen Sie den Zeitbereich. 

3. Erstellen oder wählen Sie eine Konfigurationsdatei (nur wenn Sie die Konfiguration 
ändern möchten, ansonsten wird die zuletzt gewählte Konfiguration verwendet). 

4. Klicken Sie auf den ASCII-Reportgenerator ( ). 

5. Geben Sie den neuen Dateinamen an. 

 
G_protrepasciisave.bmp 



1760 
Referenzhandbuch 

7-12 

Es wird eine ASCII-Datei (name.txt) angelegt, die mit jedem Texteditor bearbeitet 
werden kann. Alternativ können Sie die Daten in eine Datenbank oder eine ähnliche 
Anwendung importieren.  

 
G_protasciifile.bmp 

MS EXCEL® Berichte 
1. Wählen Sie die Messdaten. 

2. Wählen Sie den Zeitbereich. 

3. Heben Sie die Auswahl von Auto-Report (Auto Report) im Dialog 
Exportkonfiguration (Export Setup) auf.  

4. Erstellen oder wählen Sie eine Konfigurationsdatei (nur wenn Sie die Konfiguration 
ändern möchten, ansonsten wird die zuletzt gewählte Konfiguration verwendet). 

5. Wählen Sie eine der Dateien Export_...xls aus.  

6. Klicken Sie auf die Schaltfläche Excel Export  in der oberen Werkzeugleiste des 
Programmfensters. 

Excel wird geöffnet und eine temporäre Datei TmpExp0.xls wird erstellt. Die Messgrößen 
erscheinen in Tabellenblättern. Die Zahl der Zeilen ist variabel und hängt vom 
exportierten Zeitintervall ab. 
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G_excel-export.bmp 

Hinweis 
Die für den Export benötigte Zeit hängt von der ausgewählten Zeitperiode 
und von der Anzahl der exportierten Parameter ab. 

Tabellenblätter  Inhalt 

Einstellungen 

Dateiname 
Anwendertexte 
Alle wichtigen Einstellungen für die Messung, wie Grenzwerte und Wandlerfaktoren 
der Messkanäle. 

Messwerte  

Die in Spalten angeordneten Messwerte, wie sie in der Konfigurationsdatei festgelegt 
wurden. Die Zahl der Zeilen ist variabel und hängt vom exportierten Zeitintervall ab. 
Im nächsten Tabellenblatt Chartx werden für jede Messgröße Diagramme (samt 
Legende usw.) erstellt. 

Dieses Excel-Tabellenblatt kann unter einem neuen Namen gespeichert werden. Es lassen 
sich grafische Diagramme über alle gewünschten Messwertreihen unter Verwendung 
aller Excel-Auswertemöglichkeiten erzeugen.  

Hinweis 
Fehlen in den Daten Messgrößen, die in der Konfigurationsdatei 
vorgesehen sind, entstehen in der Excel-Tabelle an dieser Stelle leere 
Spalten. Die Position der Spalten bleibt unverändert. 
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MS Word®-Berichte  
Wählen Sie in den Exporteinstellungen die mitgelieferte Datei Export_to_Word.xls (inkl. 
in der Software) als Excel-Makro-Datei für den Export. Über das darin enthaltene Makro 
können Sie automatisch einen perfekt formatierten Bericht in Word erstellen. 

 
G_exporteditor.bmp 

1. Öffnen Sie die Messdatei. 

2. Wählen Sie den Zeitbereich mit den roten Cursormarken.  

3. Klicken Sie auf die Schaltfläche Excel Export  in der oberen Werkzeugleiste des 
Programmfensters. 

4. Die Datei Export_to_Word.xls wird mit Excel geöffnet. Sie enthält ein Makro und 
eine temporäre Datei TempExp.xls, die der aktuelle Report ist, der nach Word 
übertragen werden wird. 

Diese enthält im ersten Tabellenblatt Einstellungen (Settings) den Dateinamen, die 
Anwendertexte und alle für die Messung wichtigen Einstellungen wie Grenzwerte (limit 
values) und Wandlerfaktoren (conversion factors) der Messkanäle. Im zweiten 
Tabellenblatt Daten (Data) finden Sie die in Spalten angeordneten Messwerte, wie sie in 
der Konfigurationsdatei festgelegt wurden. 

Für jedes Diagramm wird zusätzlich ein neues Tabellenblatt Tabelle xxx (Chart xxx) 
angelegt. Die Zahl der Zeilen ist variabel und hängt vom exportierten Zeitintervall ab. 

Im Tabellenblatt erscheint folgende Werkzeugleiste. 

 
G_export_to_word_tools.bmp 
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Zusätzliche Exporteinstellungen 

Um zusätzliche Exporteinstellungen vorzunehmen, klicken Sie auf , um auf das 
Fenster Einstellungen (Settings) zuzugreifen. 

 
G_settingsdialog.bmp 

Skalierung der Diagrammskala 
Skalierung der Diagrammskala Automatisch (Automatic) oder Manuell (Manual): Bei 
Manuell (Manual) ist ein unterer Grenzwert (Min) und oberer Grenzwert (Max) der Skala 
einzugeben, zusätzlich kann eine Vorsilbe wie Kilo, Mega usw. eingegeben werden. Bei 
Automatisch (Automatic) werden die Bereiche und auch die Vorsilbe für optimale 
Darstellung automatisch gewählt.  



1760 
Referenzhandbuch 

7-16 

Auswahl der Zeitperiode 

 
G_timeselect.bmp 

Auswahl zwischen Ausgew. Periode (Selected period), Tage (Daily) oder Wochen 
(Weekly). 

Einstellungen Beschreibung 

Ausgew. Periode 
(Selected period) 

Die Diagramme in den Tabellenblättern werden über die Zeitperiode erstellt, 
der in der Software für den Export ausgewählt wurde. 

Tage (Daily) Es werden zum aktuellen Tabellenblatt neue Tabellenblätter angelegt, jeweils 
1 Wochentag wird pro Tabellenblatt dargestellt, soweit exportierte Daten 
vorhanden sind.  

Wochen (Weekly) Die Diagramme werden über eine Woche innerhalb der Exportperiode 
gebildet. 

Geben Sie den Wochentag für den Beginn und das Ende der Darstellung an. Achten Sie 
darauf, dass wirklich alle Wochentage eingetragen sind, wie z. B. Mo-So. Sa-So liefert 
nur einen Tag. 

 
G_beginn-ende-tag.bmp 

Aktivieren Sie die Schaltfläche Auf alle Diagramme anwenden (Apply to all charts), 
um die Einstellungen für das aktuelle Tabellenblatt auf alle anderen Tabellenblätter 
anzuwenden. 

 
G_apply_to_all.bmp 

Aktivieren Sie das Kontrollkästchen Flaggingdaten anzeigen (Show Flagging Data), um 
die geflaggten Daten in den exportierten Diagrammen hervorzuheben. 

 
G_flagging.bmp 

Klicken Sie auf OK , um das Konfigurationsfenster zu schließen und die Einstellungen 
auf die Messdiagramme anzuwenden. 

 
ok.bmp 
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Klicken Sie auf diese Schaltfläche, um die Diagramme aus der Excel-Datei an die Word-
Vorlage zu übertragen. 

 
icon word-report.bmp 

Wählen Sie eine der mitgelieferten Word-Vorlagen oder eine von Ihnen vorbereitete 
Datei aus. 

 
G_exportselectwordtemplate.bmp 

Verwenden Sie folgende Platzhalter in Word-Berichten:  

Platzhalter Verwendung 

#settings# für die Einstellungen 

#pic1#, #pic2# für Diagramme 

#table1#, #table2# für Tabellen (Legenden von 
Diagrammen) 

#EN50160# EN50160-Bericht 

Die Diagramme werden in das Word-Dokument eingefügt, und es wird ein 
wohlformatierter Bericht erstellt. Diese Exportfunktion spart Zeit und gewährleistet ein 
einheitliches Layout der Berichte insbesondere bei wiederkehrenden Messungen.  

Angepasste Excel-Berichte 
Sie können anwenderdefinierte Excel-Berichte erstellen. 

Das Excel-Exportmakro bietet folgende Funktionen:  

• Kopieren der Daten in das erste Tabellenblatt einer anwenderdefinierten 
Arbeitsmappe  
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• Aktualisieren aller vorhandenen Diagramme  

• Erstellen von Verweisbezeichnungen für die Daten  

Die PQ Analyze Software verfügt über Beispiele, die die Funktionsweise verdeutlichen. 

Anpassen des Excel-Exportmakros  
Der Datenexport wird durch ein Excel-Makro gesteuert, das in der Excel-Arbeitsmappe 
Export_to_Word.xls enthalten ist. Das Verhalten dieses Makros können Sie über den 
Wert der Option UserSwitch konfigurieren (siehe unten). Unterschiedliche Einstellungen 
der Option UserSwitch stellen unterschiedliche Funktionen bereit. Um Daten in eine 
angepasste Exel-Vorlage exportieren zu können, müssen Sie die folgenden Schritte unten 
durchführen.  

1. Starten Sie PQ Analyze. 

2. Öffnen Sie den Dialog Exportkonfiguration (Export setup) (Menü Optionen > 
Exportkonfiguration  (Options > Export setup)), und heben Sie die Auswahl von 
Auto-Report (Auto Report) auf. Schließen Sie den Dialog durch Klicken auf OK. 

3. Wechseln Sie in Windows Explorer zum Ordner  
<Anwendungsdaten>\PQAnalyze\Export (<AppData>\PQAnalyze\Export), und 
öffnen Sie die Excel-Arbeitsmappe Export_to_Word.xls. 

4. Wenn ein Fenster mit einer Sicherheitswarnung angezeigt wird, klicken Sie auf die 
Schaltfläche Makros deaktivieren (Disable Macros). 

 
G_excelmacrowarning.bmp 

Hinweis 

Wenn dieses Fenster nicht angezeigt wird, ist eine niedrige Sicherheitsstufe 
eingestellt. In diesem Fall startet das Makro automatisch. Dies ist 
unproblematisch, sofern Sie nicht die Option „Auto-Report“ (Auto Report) 
unter „Optionen > Exportkonfiguration“ (Options > Export Setup) in PQ 
Analyze aktiviert haben. In diesem Fall wird die Datei unmittelbar nach 
Ausführen des Makros geschlossen.  
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5. Geben Sie die Konfigurationseinstellung select in der Zelle neben UserSwitch ein: 

 
G_excelexporttowordselect.bmp 

Folgende Einstellungen sind zulässig: 

Text Beschreibung 

Select 
Der Anwender wird aufgefordert, eine Excel-
Vorlage auszuwählen. 

Template\CustomCharts.xls Der relative Pfad zu einer MS Excel®-Vorlage 

<Anwendungsdaten>\PQAnalyze\ 
Export\Template\CustomCharts.xls 
(<AppData>\PQAnalyze\ 
Export\Template\CustomCharts.xls) 

Der absolute Pfad zu einer MS Excel®-Vorlage. 
Ersetzen Sie <Anwendungsdaten> (AppData) 
durch den Speicherort des Verzeichnisses 
„Anwendungsdaten“ (AppData) (siehe Kapitel 
„Installationspfade“) 

6. Speichern Sie die Arbeitsmappe unter einer anderen Bezeichnung (z. B. 
Export_to_Word_select.xls), und schließen Sie Excel. 
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Excel-Vorlage CustomCharts.xls 

Hinweis 
Im unten stehenden Beispiel werden die Demodaten (feeder1.def) von der 
CD-ROM verwendet, um die Funktionsvielfalt zu erläutern. Auf Ihrer CD-
ROM sind möglicherweise andere Demodaten vorhanden, oder Sie können 
eine andere Messdatei mit einer Spannungs-/Stromsystemkonfiguration 
verwenden. 

Die Vorlage CustomCharts.xls kann zusammen mit der Export-Setup-Datei 
ExportSetup_sample.ini verwendet werden. Wenn die Setup-Datei geändert oder eine 
andere Export-Setup-Datei verwendet wird, muss eine neue Exportvorlage erstellt werden 
(siehe „Erstellen einer angepassten Excel-Vorlage“).  

• Starten Sie PQ Analyze, und öffnen Sie eine Messdatei (Datei > Öffnen (File > 
Open)). 

• Öffnen Sie den Dialog Exportkonfiguration (Export setup) (Menü Optionen > 
Exportkonfiguration (Options > Export setup)), und konfigurieren Sie die 
Exporteinstellungen: 

1. Deaktivieren Sie die Option Auto-Report (Auto Report). 

2. Geben Sie im Feld EXCEL Makro (EXCEL Macro) die Excel-Arbeitsmappe 
an, die Sie zu diesem Zweck erstellt haben (Export to Word select.xls) (siehe 
“Anpassen des Excel-Exportmakros“). 

3. Geben Sie im Feld Exportkonfiguration (Export setup) die Setupdatei 
ExportSetup_sample.ini an. 

• Schließen Sie den Dialog Exportkonfiguration (Export setup). 

• Wählen Sie den gewünschten Zeitbereich aus, und klicken Sie auf die Schaltfläche 
Excel: 

 
G_excelprotocolreportgenerator.bmp 
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• Da der UserSwitch „select“ angegeben wurde, werden Sie aufgefordert, eine Excel-
Vorlage auszuwählen. Wählen Sie die Datei CustomCharts.xls im Ordner Template 
aus: 

 
G_excelopencustomcharts.bmp 
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Dadurch werden die Diagramme in dieser Arbeitsmappe mit den neuen Exportdaten 
aktualisiert: 

 
G_excelcustomcharts.bmp 
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Das Makro öffnet die Arbeitsmappe schreibgeschützt, um das Überschreiben der Vorlage 
zu verhindern. Um den Bericht zu archivieren, speichern Sie ihn unter einer anderen 
Bezeichnung – bevorzugt unter Ihrem Verzeichnis <Persönlich> (Personal), z. B. 
„Eigene Dateien\PQAnalyze\MyReport.xls“ (My 
Documents\PQAnalyze\MyReport.xls) (siehe „Installationspfade“). 

Erstellen einer angepassten Excel-Vorlage 
1. Starten Sie PQ Analyze, und öffnen Sie eine Messdatei (Datei > Öffnen (File > 

Open)). 

2. Öffnen Sie den Dialog Exportkonfiguration (Export setup) (Menü Optionen > 
Exportkonfiguration (Options > Export setup)), und konfigurieren Sie die 
Exporteinstellungen: 

• Deaktivieren Sie die Option Auto-Report (Auto Report). 

• Geben Sie im Feld EXCEL Makro (EXCEL Macro) die Excel-Arbeitsmappe 
an, die Sie zu diesem Zweck erstellt haben (Export_to_Word_select.xls) (siehe 
auch „Anpassen des Excel-Exportmakros“). 

• Geben Sie im Feld Exportkonfiguration (Export setup) eine Ihrer nicht leeren 
Setup-Dateien an. 

3. Schließen Sie den Dialog Exportkonfiguration (Export setup). 

4. Wählen Sie den gewünschten Zeitbereich aus, und klicken Sie auf die Schaltfläche 
Excel. 

5. Wenn Sie dazu aufgefordert werden, wählen Sie die Excel-Vorlage 
CustomCharts_Template.xls im Ordner Template aus. Klicken Sie in der Excel-
Arbeitsmappe auf die Schaltfläche Start. Dadurch werden so viele Diagramme 
erstellt, wie für den Bericht erforderlich sind (basierend auf der ausgewählten Datei 
export setup.ini ). 

6. Speichern Sie die erstellte Excel-Vorlage unter einer anderen Bezeichnung 
(bevorzugt im Verzeichnis <Anwendungsdaten>\PQAnalyze\Export\Vorlage 
(<AppData>\PQAnalyze\Export\Template)), und schließen Sie alle Excel-
Arbeitsmappen.  

Hinweis 
Wenn Sie aufgefordert werden, Änderungen an der Datei 
Export_to_Word_select.xls zu speichern, können Sie dies ablehnen.  

7. Klicken Sie in PQ Analyze erneut auf die Schaltfläche Excel, und wählen Sie die neu 
erstellte Excel-Vorlage für den Export aus. Wenn Sie dazu aufgefordert werden, 
aktualisieren Sie Verknüpfungen zu anderen Datenquellen.   

8. Ordnen Sie die Position der Diagramme an, fügen Sie Text und Überschriften sowie 
Ihr Firmenlogo hinzu, und passen Sie die Excel-Arbeitsmappe an Ihre Anforderungen 
an. 

9. Speichern Sie die Arbeitsmappenvorlage, und verwenden Sie sie für wiederholt zu 
erstellende Berichte.   

Hinweis 
Die Vorlagendatei wird stets nur schreibgeschützt geöffnet. Daher müssen 
Sie sie mit einer anderen Dateibezeichnung speichern. 
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Details des Excel-Exportmakros  
In diesem Abschnitt wird die Funktionsweise des Makros erläutert. 

• Das Excel-Exportmakro erstellt eine neue Arbeitsmappe oder öffnet eine vorhandene, 
je nach Einstellung von UserSwitch. Es kopiert die Daten des gewünschten 
Zeitbereichs in das erste Tabellenblatt. Die vorhandenen Daten in dem Blatt werden 
gelöscht, bevor die Daten eingefügt werden, so dass das gesamte Blatt nur für die 
Messdaten reserviert wird.  

• Der Zeitbereich der Diagramme wird aktualisiert, und die X-Achse wird 
entsprechend dem angezeigten Zeitbereich korrekt beschriftet. 

• Die Einheiten beider Achsen werden aktualisiert. 

• Die Einstellungen der Y-Achse bleiben unverändert. Wenn die Diagramme mit 
manueller Skalierung definiert worden sind, können die Datenzeilen möglicherweise 
nicht angezeigt werden, da sie sich außerhalb des Bereichs befinden. 

• Das Makro aktualisiert in Abhängigkeit vom Index ein Diagramm nach dem anderen. 
Der Index entspricht dem Erstellungsdatum. Wenn Sie Diagramme manuell erstellen, 
achten Sie darauf, dass Sie die Diagramme von oben nach unten erstellen, um zu 
vermeiden, dass Diagramme vertauscht werden. 
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Kapitel 8 
Menüreferenz 

Menü: Datei (File) 
In den folgenden Abschnitten werden die Befehle des Menüs „Datei“ (File) erläutert.  

Datei > Neu (File > New) 
Gleiche Funktion wie die Schaltfläche Datei Neu (File New). Dient der Einrichtung einer 
neuen Messung (ausführliche Informationen finden Sie in Kapitel 5: „Einrichten von 
Messungen“).  

 

Datei > Öffnen (File > Open)  

1. Mit Datei > Öffnen (File > Open) oder durch Klicken auf  kann eine bereits 
vorhandene Vorlage/Definitionsdatei (*.vdf) oder eine Messdatei zum Auswerten 
(*.def) geöffnet werden. 

2. Eine Vorselektion nach Dateityp verbessert die Übersicht. Sie können die Parameter 
einer vorhandenen Datei im Fenster „Einstellungen“ (Settings) anpassen.  

Für verschiedene Applikationen stehen Vorlagedateien zur Verfügung. Diese können 
auch angepasst und als neue Vorlagen gespeichert werden.  

Datei > Speichern (File > Save) 
Eine geöffnete Messdatei kann unter einem anderen Namen gespeichert werden.  

1. Öffnen Sie die Datei. 

2. Geben Sie den neuen Dateinamen im Feld Dateiname (File Name) an. 

Die PQ Analyze-Software übernimmt diesen neuen Dateinamen für alle Dateien des 
Messdateisatzes. Die alten Dateien bleiben erhalten, sodass die Messung tatsächlich 
kopiert wird. 
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Datei > Drucken (File > Print)  

 
G_printer.bmp 

Mit Datei > Drucken (File - Print) bzw. durch Klicken auf  kann die aktuelle 
Messung (Bildschirm mit allen geöffneten Fenstern) ausgedruckt werden. Schwarz/Weiß 
oder Farbe (Color)  und die Anzahl der Exemplare können gewählt werden. 

Hinweis 
Für den Ausdruck von Diagrammen können Sie auch Bitmaps wählen 
(BMP Druck (BMP Printing)) – damit umgehen Sie einige Probleme mit 
der Skalierung und Auflösung bei bestimmten Netzwerkdruckern. 

Datei > Löschen (File > Delete) 
Durch Aufrufen der Funktion Datei > Löschen  können nicht mehr benötigte Dateien 
gelöscht werden. Geben Sie zu diesem Zweck die Bezeichnung der zu löschenden Datei 
ein, und bestätigen Sie mit Auswählen (Select). Dateien können nur gelöscht werden, 
wenn keine Messdatei geöffnet ist.  

Hinweis 
Gelöschte Dateien können nicht mehr wiederhergestellt werden. 

Fluke 1760 > Start Menü (Fluke 1760 > Start Menu) 
Wählen Sie Fluke 1760 > Start Menü (Fluke 1760 > Start Menu), um den 
Startbildschirm auch dann zu öffnen, wenn er durch die entsprechende Option 
unterdrückt wird. 

Datei > Schließen (File > Exit) 
Mit diesem Befehl schließen Sie die PQ Analyze-Software. 
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Menü: Messung (Measurement) 

 
G_measurementmenu.bmp 

Messung > Einstellungen (Measurement > Settings) 
Die Einstellungen einer geöffneten Messung können geprüft werden. 

EXCEL-Reportgenerator (EXCEL Protocol Report Generator) 
Ein automatisches Messprotokoll wird auf der Grundlage vorbereiteter Vorlagen erstellt. 
Weitere Details siehe Kapitel 7: „Export von Messdaten“. 

ASCII-Reportgenerator (ASCII Protocol Report Generator) 
Der ASCII-Reportgenerator erlaubt die Eingabe eines Dateinamens für die Ausgabe eines 
Textprotokolls der geöffneten Messung. Weitere Details siehe Kapitel 7: „Export von 
Messdaten“. 

Messparameter 
Auf die meisten Analysefunktionen kann auch über das Menü Messung (Measurement) 
zugegriffen werden. 

Dieses Menü bietet jedoch zusätzlich zu den Symbolen für Messparameter und 
Analysewerkzeuge einige spezielle fortgeschrittene Funktionen und Parameter. Dabei 
handelt es sich um eine Sammlung von Werkzeugen, die sich bei bestimmten 
Anwendungen als hilfreich erwiesen haben. Einige dieser zusätzlichen Merkmale werden 
im Folgenden beschrieben. 

Oberschwingungen und Zwischenharmonische (Harmonics, Interharmonics) 
Diese Option bietet ein interaktives Auswahlfeld zur Hinzufügung individueller 
Oberschwingungen oder Zwischenharmonischer zum Auswertefenster.  
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G_harmonicsselection.bmp 

In der Gruppe Oberschwingungen (Harmonics) und Zwischenharmonische  
(Interharmonics) ist das Werkzeug U/I (x-y plot) (V/I (x-y plot)) verfügbar. Damit ist es 
möglich, die U/I-Kennwerte einer bestimmten Oberschwingung zu plotten und die 
Stromnetzimpedanzen bei verschiedenen Frequenzen abzuschätzen.  

 
G_vi_plot.bmp 
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Oszilloskop (Oscilloscope) 
Spektrumanzeigen für die Systemkomponenten (Nullkomponente, Mitkomponente, 
Gegenkomponente) sind verfügbar. 

K-Faktor (K-Factor) 
Der K-Faktor ist ein spezieller Parameter zur Bewertung der Erwärmung von 
Transformatoren bei vorhandenen Stromoberschwingungen. Ein K-Faktor von 3 bedeutet 
beispielsweise, dass durch verzerrte Stromwellen dreimal so viel Wärme im 
Transformator erzeugt wird wie durch einen rein sinusförmigen Strom.  

Faktor K (Factor K) 
Der Faktor K ist ein Transformator-Reduktionsfaktor. Wird der Transformatorstrom 
durch Stromoberschwingungen verzerrt, ergibt sich bei diesem Parameter ein 
Reduktionsfaktor größer 1. Dieser Faktor wird verwendet, um die Nennleistung des 
Transformators zur Vermeidung von Überhitzung herabzusetzen. Bei einem Faktor K 
von 1,25 muss der Transformator beispielsweise auf 80 % (1/1,25) seiner 
Nennbelastbarkeit heruntergefahren werden. 

Menü: Übertragen (Transfer) 

Übertragen (Transfer) > FLUKE 1760 
Siehe auch „Kapitel 3: Kommunikation mit dem Rekorder“. 

Übertragen > Einstellungen ändern (Transfer > Change Settings) 
Wenn eine Verbindung zum Rekorder hergestellt ist, können einige Einstellungen (in 
erster Linie Triggerschwellwerte) während der Durchführung von Messungen 
vorgenommen werden. 

Übertragen > Messdaten holen (Transfer > Download Measurement Data) 
Dieser Befehl überträgt die im Gerät gespeicherten Daten zum Auswerterechner. Dies 
kann jederzeit erfolgen, ohne die laufende Messung zu beeinträchtigen. 

Übertragen > Online-Betrieb (Transfer > Live Mode) 
Im Online-Betrieb (Live Mode) werden die Momentanwerte und die Frequenzspektren 
der aktuell anliegenden Signale angezeigt.   

Um den Online-Betrieb (Live Mode) zu aktivieren, klicken Sie auf Übertragen > 
Online-Betrieb (Transfer > Live Mode).  

 
G_livemode.bmp 
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Holen neuer Messdaten 

Das Holen neuer Messdaten vom Gerät kann zeitgesteuert automatisch erfolgen (Timer 

EIN (Timer ON))  oder manuell durch Klicken auf die Schaltfläche  Aktualisieren 
(Refresh). 

 

 
Hardware-Einstellungen für den Live-Betrieb  

Hinweis 
Diese Einstellungen gelten nur für den Online-Betrieb. 

 
G_online-refresh-hardware.bmp 

Punkte (Samples) 
Anzahl der Abtastwerte (Samples) einer Messung. 

1024 ist für Messungen im Versorgungsnetz ausreichend. 

Die Anzahl der Abtastwerte hat Auswirkungen auf die Datenübertragungszeit.  
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Oszilloskop-Online-Anzeige 

 
G_8_1.bmp 

Klicken Sie auf die Schaltfläche , um Kurvenformen auszuwerten. 

Um neue Messdaten zu holen, klicken Sie auf . 

Nun können über die Icons der Werkzeugleiste Diagramme erzeugt werden. 

Hinweis 
Nähere Angaben zu Auswertungsfunktionen im Live-Modus finden sich 
auch in „Kapitel 6: Analyse von Messdaten – Analyse getriggerter 
Aufnahmen“. 

Ereignisse – Online-Betrieb-Anzeige 

 
G_onlinerefresh-ereignisse.bmp 

Die Ereignisanzeige für Online-Betrieb (Live Mode) zeigt alle aktiven Ereignisse an und 
hilft bei der optimalen Einstellung der Triggerschwellen. 

Durch Anklicken der Schaltfläche Ereignisse (Events) im Fenster „Aktualisieren“ 
(Refresh) können die zum aktuellen Zeitpunkt aktiven Ereignisse dargestellt werden. 
Abgeschlossene Ereignisse werden nicht angezeigt. Die aktiven Ereignisse können 

sowohl in Form einer Liste als Ereignisauswertung  als auch als Eintrag in das 

CBEMA-Diagramm  angezeigt werden. 

Hinweis 
Aktive, aber nicht abgeschlossene Ereignisse sind dadurch erkennbar, dass 
keine Dauer angegeben wird. 

Durch Doppelklicken auf ein Ereignis werden alle dazugehörigen 
Aufzeichnungen in geeigneten Diagrammfenstern geöffnet.  
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Transienten-Online-Betrieb 
Dieses Fenster zeigt die aktuellen Momentanwerte und die Frequenzspektren.  

 
G_livemodhardwaresettings.bmp 

Im Fenster Hardware-Einstellungen > Transientenanalyse (Hardware Settings > 
Transient Analysis) wurden die Kanäle gewählt, die angezeigt werden sollen, und die 
Anzahl der Abtastwerte pro Messung. Die Messdauer hängt von der eingestellten 
Abtastrate ab.  

Die Abtastrate kann unter dem Menüpunkt Einstellungen > Aufzeichnungsmodi 
(Settings > Recording Modes) zwischen 100 kHz und 10 MHz gewählt werden. 

Die Anzahl dieser Abtastwerte hat Auswirkungen auf die Datenübertragungsdauer und 
auf die Frequenzauflösung der Spektralanalyse. 

Es wird empfohlen, die nicht benötigten Kanäle auf off ( ) zu schalten.  
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Menü: Service 

Service > Kalibration (Calibration)  

 
G_calibration.bmp 

Diese Funktion zeigt die Verstärkungsfaktoren für die acht Messkanäle CH1 bis CH8 und 
die in den Sensoren gespeicherten Kalibrationsdaten.  

Hinweis 
Diese Verstärkungsfaktoren dürfen vom Anwender nicht verändert werden, 
da sie direkten Einfluss auf die Genauigkeit des Gerätes haben. 
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Durch Klicken auf die Schaltfläche EEPROM wird ein Fenster geöffnet, das die 
Kalibrationsdaten der angeschlossenen Sensoren zeigt: 

 
G_calibration eeprom.bmp 

Hinweis 
Der Identifikationsstring eines Sensors kann nicht geändert werden. 
Anderenfalls kann die Messeinrichtung möglicherweise vom Gerät nicht 
mehr erfasst werden. 
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Service > Statustest (Status Test)  

 
G_statustest.bmp 

Dieser Statustest zeigt folgende Informationen über das Gerät an: 

• Systemdatum und -uhrzeit am Gerät 

• Zeitzone  

• Gerätename 

• Art des Datenspeichermediums 

• MAC-Adresse 

• Am Gerät installierte Optionen 

• Verstärkungsfaktoren der Messkanäle  
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• Gültigkeit der angeschlossenen Sensoren 

• Akkumulator: Spannung, Temperatur, Strom, Kapazität  

• Status von Alarmein- und -ausgängen 

• Status der GPS-Option  

Service > Zeiteinstellung  (Set Time)  

 
G_servicesettime.bmp 

Zeit lokal (Local 
time): 

gibt die aktuelle Zeit am Auswerterechner (PC) an 

Gerät:  
(Gerätezeit) 

zeigt die aktuelle Uhrzeit des Gerätes an  

Sync:  
(Synchronisieren) 

Mit der Taste Sync wird die Systemzeit des PC vom Gerät übernommen. 

OK: OK überträgt die aktuelle Uhrzeit zum Gerät und schließt das Fenster. 
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Service > Erweiterte Einstellungen (Advanced Settings) 
Das Menü Erweiterte Einstellungen (Advanced Settings) öffnet ein Textmenü zur 
Änderung nicht häufig genutzter erweiterter Einstellungen. Folgen Sie den Anweisungen 
im Textmenü, um diese Einstellungen zu ändern.  

 
advancedsettingsmainmenu2.bmp 

Service > Zeitsynchronisierung Einstellungen (Time Synchronization 
Configuration) 

Wählen Sie das Protokoll und die Parameter für die Zeitsynchronisation. 

 
G_timesynchronization.bmp 

Hinweise 
• Mit der Statustestfunktion können Sie den Status des GPS-

Empfängers kontrollieren. Wählen Sie dazu die Optionsfolge 
Service > Statustest (Status test), und gehen Sie zum Ende der 
Liste. 
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GPS: Off 
Die GPS-Option ist im Menü Service – GPS-Einstellungen (GPS Configuration) 
deaktiviert worden (Einstellung None (Keine)). 

GPS: Invalid 
Die GPS-Option ist im Menü Service – GPS-Einstellungen (GPS Configuration) 
aktiviert worden (Einstellung NMEA0183), doch ist diese Option nicht mit dem Fluke 
1760 verbunden. 

GPS: Unlocked 
Das Gerät empfängt korrekte Protokolldaten von einer verbundenen GPS-Option, aber 
die Zeitsynchronisation ist noch nicht erreicht (möglicherweise zu wenige Satelliten im 
Empfangsbereich oder zu schwache Signalstärke). 

GPS: Locked 
Datenpakete mit korrekte Zeitdaten enthaltendem Protokoll werden über die serielle 
Schnittstelle des Geräts empfangen. Das Gerät wird mit der UTC (Universal Coordinated 
Time) synchronisiert. 

Service > Firmware aktualisieren (Firmware Update) 
Aktualisiert die Firmware des Rekorders. Die neueste Firmware ist immer Bestandteil 
einer neuen Auswertesoftware (auf der mitgelieferten CD-ROM enthalten). 

Hinweise 
Für eine ordnungsgemäße Funktion muss auf dem Gerät dieselbe 
Softwareversion wie auf dem Auswerterechner (PC) installiert sein. 

Wenn eine direkte oder eine Modemverbindung zwischen dem PC und dem 
Rekorder besteht, wird das Firmware-Update aufgrund der geringen 
Verbindungsgeschwindigkeit deaktiviert.  

Menü Fenster (Window) 

Fenster > Liste (Window > List) 
Zur Erhöhung der Benutzerfreundlichkeit gibt es Optionen zum Schließen aller Fenster 
eines bestimmten Typs:  

• Alle Diagramme schließen (Close all graphs) 

• Alle Tabellen schließen (Close all tables) 

• Alle schließen (Close all) 

Dies ist sehr nützlich, wenn viele Auswertungsfenster offen sind und sofort geschlossen 
werden müssen.  

Fenster > Drucken (Window > Print) 
Das Menü „Fenster“ (Window) Drucken öffnet eine Auswahlliste aller geöffneten 
Fenster. 

Wählen Sie alle Fenster aus, die gedruckt werden sollen, und bestätigen Sie mit OK. 



 Menüreferenz 
 Menü: Optionen (Options) 8 

  8-15 

 
G_prin1.bmp 

Das Menü „Fenster“ (Window) zeigt eine Liste derzeit geöffneter Diagrammfenster. 

Durch Anklicken der Bezeichnung eines Fensters wird dieses in den Vordergrund 
gestellt.  

Fenster > Zwischenablage (Window > Clipboard) 
Es erscheint eine Auswahlliste der geöffneten Fenster.  

Die einzelnen Fenster können mit der Maus markiert und anschließend in die 
Zwischenablage übernommen werden. So lassen sich Auswertungen (Diagramme), 
Ereignisse und Triggereinstellungen in eine Word- oder Excel-Datei übernehmen. 

Hinweis 
Es kann immer nur ein Fenster in die Zwischenablage kopiert werden. 

Menü: Optionen (Options) 

Optionen > Sprache wählen (Options > Choose Language) 

Sprache wählen 
Wählen Sie die gewünschte Sprache der Benutzeroberfläche. 

Optionen > Leistungsfaktor (Options > Power Factor) 
Es gibt verschiedene Algorithmen zur Berechnung des Leistungsfaktors in Abhängigkeit 
von der jeweiligen Anwendung. Wählen Sie die passende Formel.  

 
G_optionspowerfactor.bmp 
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Hinweis 
Wählen Sie die benötigte Formel, bevor Sie die Messdatendatei öffnen. 

In der ersten Formel definiert das Vorzeichen der Blindleistung Q das 
Vorzeichen des Leistungsfaktors. Je nach Lasttyp (induktiv oder kapazitiv) 
ändert sich das Vorzeichen des Leistungsfaktors.  

Die zweite Formel ist die klassische Definition. Das Vorzeichen ist das 
Wirkleistungszeichen und gibt somit die Leistungsflussrichtung an.  

Zusätzlich kann die Skalierung der Diagramme definiert werden. 

 
G_leistungsfaktor-skalierung.bmp 

Hinweis 
Wählen Sie die benötigte Formel, bevor Sie die Messdatendatei öffnen. Die 
zweite Skalierungsmethode ist optimal, wenn der Leistungsfaktor 
permanent um +/-1 fluktuiert. Das Diagramm ist dann nicht mit vertikalen 
Linien überladen.  

Der zweite Typ wird im Allgemeinen für Leistungsmessanwendungen bei 
der Energieverteilung verwendet. 

Optionen > Plt-Berechnung (Options > Plt Calculation) 
Der Langzeitflicker Plt wird auf der Grundlage der Pst-Werte berechnet. Wählen Sie den 
Abgleich des Plt-Intervalls (2 Stunden). 

Optionen > Default Definition-Datei (Options > Default Definition File) 
Hier können Sie auswählen, welche der Default.def-Dateien, z. B. euro.def, beim Öffnen 
von Menü Datei > Neu (File > New) geladen werden soll. Diese Dateivorlagen haben der 
Region entsprechend angepasste Vorgabewerte (z. B. in den USA f= 60 Hz). 
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G_defaultdef.bmp 

Im Verzeichnis vdf_10 finden Sie diese mitgelieferten Dateien. Diese können Sie auch 
bearbeiten, um z. B. Grenzwerte entsprechend Ihren Anforderungen anzupassen.  

Optionen > Stationen konfigurieren (Options > Configure Sites) 
In diesem Menüpunkt können Geräte mit Stationsnamen und Gerätenamen versehen 
werden. Die Verbindungsaufnahme erfolgt dann über Menü „Transfer“ und den 
Stationsnamen. 

Geben Sie alle Geräteinformationen ein: 

• Stationsname 

• Gerätename 

• IP-Adresse 

• Telefonnummer des Modems, falls verfügbar 

• Broadcast-Adresse 

• Netzwerk 

 
G_stationconfiguration.bmp 
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Optionen > Tabelle (Options > Table) 

 
G_Option Table.bmp 

Prinzip 

Auswahl Beschreibung 

Dezimaltrennzeichen 
(Decimal Delimiter) 

Auswahl der Formatierung der Dateien für den Export in 
Tabellenkalkulationsprogramme (Text Datei). Das Dezimalzeichen ist 
landesabhängig ein Beistrich oder Punkt.  
Wählen Sie Ihre Einstellung, damit der Dateiexport ins 
Tabellenkalkulationsprogramm korrekt funktioniert. 

Hohe Zeitauflösung 
verwenden (High time 
resolution) 

Ist diese Einstellung aktiv, werden bei den Zeitangaben auch 
Sekundenbruchteile angezeigt. Dies kann bei Ereignissen wichtig 
(nützlich) sein. 

Gewählte Einstellungen 
speichern (Save selected 
settings) 

Die Einstellungen werden als Vorgaben gespeichert und bleiben auch 
nach dem Beenden und Neustart erhalten.  
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Optionen > Kurvenattribute Diagramm (Diagram Attributes)  

 
G_opt_kuven_attribute_a.bmp 

Jeder Kurve kann eine beliebige Farbe und Strichstärke zugeordnet werden. Die 
Einstellungen werden als Vorgaben gespeichert und bleiben auch nach dem Beenden und 
Neustart der PQ Analyze-Software erhalten. Ist das Kontrollkästchen Alle einstellen (Set 
all) aktiviert, wird dieser Linienstil für alle Kurven verwendet, was die Einstellungen 
erleichert. 

Im Feld Flagging können Sie die Farbe für geflaggte Intervalle festlegen. Bei aktivierter 
Option Ausblenden (Hide) ist die Schattierung geflaggter Daten nicht mehr sichtbar. 

Optionen > Exportkonfiguration (Options > Export Setup) 
Die PQ Analyze -Anwendersoftware unterstützt die Erstellung frei konfigurierbarer 
Messwertberichte (Reports) über Excel und Word, die auf vorbereiteten Vorlagen 
basieren. Zunächst müssen Sie die zu exportierenden Variablen definieren und diese 
Informationen in einer Konfigurationsdatei speichern. 
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Vorteile 
• Die Vorbereitung (Formatierung, Konfiguration) der Vorlagen wird nur einmal 

vorgenommen. 

• Berichte mit den neuesten Messungen können mit einem einfachen Mausklick erstellt 
werden. 

• Individuelle Berichte mit den Designelementen von Excel können erzeugt werden. 

• Über das mitgelieferte Makro kann ein endgültiger Bericht in Word erstellt werden.  

Die Grundeinstellungen des Geräts und alle Diagramme aus der Excel-Datei werden in 
den Bericht eingefügt. Die Position kann durch Platzhalter wie z.B. #pic1# in der Vorlage 
bestimmt werden. Weitere Details siehe Kapitel 7: „Export von Messdaten“. 

Menü: Hilfe (Help) 
Informationen über die PQ Analyze-Softwareversion. 
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